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Chapter 1
Introduction

This chapter contains a general introduction to theOcé
TDS400. This chapter describes the main features, options
and software applications provided with the system.
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About this manual

This manual contains the following chapters:

Chapter 1: Introduction Contains a general introduction to the Océ TDS400
system, a general description of the main features, delivery options and
software applications provided with the system.

Chapter 2: Using the Océ TDS400 to print Contains a short description of
how to use the printer.

Chapter 3: Using the Océ TDS400 to copy Contains a description of how to
use the scanner to make copies.

Chapter 4: Using the Océ TDS400 to scan Describes how to scan the originals
to a file.

Chapter 5: Océ Power Logic®: The Settings Editor Gives information about
the Océ Settings Editor. For details about specific settings, refer to the Help on
the Océ Settings Editor.

Chapter 6: Océ Power Logic®: The System Control Panel Describes how to
look at the system status of the Océ TDS400.

Chapter 7: Océ Power Logic®: The Queue Manager Describes how to view
and manage jobs in the Océ TDS400 print queue, inbox queue, and history
queue. It shows how to cancel the active print and how to delete the prints, how
to hold the print jobs in the queue, how to restart the jobs, and how to move
jobs to top.

Chapter 8: Océ Power Logic®: Remote Logic describes the installation and
the functionality of the Océ TDS400 remote controller applications.

Chapter 9: Océ Account Center contains a description of how to manage the
account information of the print, copy and scan-to-file jobs with Océ Account
Logic and Océ Account Console.

Chapter 10: Printer supplies and scanner maintenance Describes how to load
paper and how to refill the toner, and how to provide maintenance to the
scanner.
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Chapter 11: How to solve problems Describes the problems that can occur
when you use the Océ TDS400.

Chapter 12: The folder Describes the folder delivered as an optional with the
Océ TDS400.

Appendix A: Summary and tables Contains the product specifications for the
Océ TDS400, a list of available material types and sizes.

Appendix B: Safety information Contains the approved weight limits,
instructions for safe use, the available safety data sheets and the correct
ENERGY STAR® specifications.

Appendix C: Miscellaneous Contains the notation conventions, a reader’s
comment sheet and the addresses of local Océ organisations.
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The Océ TDS400

The Océ TDS400 is a wide format, black and white, multifunctional system.
The Océ TDS400 offers a broad range of print, copy, and scan-to-file
functionality. The system includes a printer (1 or 2 rolls) a controller and an
optional scanner.

[1] Océ TDS400
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The Océ TDS400 concept and components

The Océ TDS400printer

The Océ TDS400 printer is available with an automatic 1- or 2-roll unit and
manual feed.Use manual feed when you want to print a job on a media type or
size that is not available on one of the paper rolls.

Note: The manual feed is a special slot just above the paper drawers on the
printer. You can insert cut sheet material in this slot, one sheet at a time.Refer
to ‘Copy on pre-cut sheets’ on page 61 on how to copy on pre-cut sheets.

Note: Only use material as specified in ‘List of available material types and
sizes’ on page 214.

The Océ TDS400 is a 600 DPI LED printer with a speed of 3 meters per
minute.

You can perform a number of activities at the Océ TDS400 printer. You can set
the media type and size, stop a print job or select your preferred language from
the printer operator panel (see Chapter 2, ‘Using the Océ TDS400 to Print’ on
page 23 for more details).

The Océ TDS400 is delivered with drivers and job submission software to
enable you to print from AutoCAD®, Windows® or Macintosh® applications.

The Océ TDS400scanner

The Océ TDS400 scanner supports a wide range of copy activities. It provides
a large number of functions for defining original and copy related settings. You
can specify particular media, feeding and quality enhancement options from
the scanner operator panel. In combination with the Océ TDS400 printer it
forms a powerful productivity tool.

The scanner scans your originals. You can print the originals (copy job) or you
can store the scanned original in a file (Océ Scan Logic®). The scanner has
different quality modes which are provided by Océ Image Logic®.
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■ Green key principle
The Océ TDS400 is easy to use. Press the green key on the scanner operator
panel to start the basic copy jobs. If you have difficult copy jobs, you change
the default copy settings with the help of the other settings on the scanner
operator panel.

The Océ Power Logic® controller

The Océ TDS400 is equipped with a controller to process the print jobs and the
copy jobs. The controller can have Océ Remote Logic® to control your print
jobs, make your default printer settings and monitor the printer status.

The Océ Power Logic® controller processes the print jobs and the copy jobs. It
also processes the optional scan to file jobs.

■ Set processing
When you send a file to the printer, the file is processed once and can be printed
many times. The Océ TDS400 has a set memory to store a maximum of 135
A0s which allows you to create the same sets that are sorted either by page or
by set.

■ Spool memory
The Océ TDS400 has a spool memory which provides a queuing system for
files you want to print. The spool memory allows many users to send the print
jobs to the Océ TDS400 at the same time. The print jobs are put in the print
queue where they wait to be printed. The job that is put first into the queue is
printed first.

■ Network connectivity
The Océ TDS400 controls a number of common network protocols. The Océ
TDS400 can be used in may networks like TCP/IP and Novell®.

Océ Settings Editor The Océ Settings Editor allows you to set the default
settings of the Océ TDS400 according to your companies requirements.

Refer to ‘Océ Power Logic®: The Settings Editor’ on page 99, for complete
information about the Océ Settings Editor application.

Océ System Control Panel The Océ System Control Panel (SCP) application
provides you with status information about the system.
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Refer to ‘Océ Power Logic®: System Control Panel’ on page 115, for
complete information about the Océ System Control Panel.

Océ Queue Manager The Océ Queue Manager (QM) application gives a
graphical design of the print queue. You can manage jobs in the print queue,
history queue, or inbox queue.

Refer to ‘Océ Power Logic®: Queue Manager’ on page 121, for complete
information about the Océ Queue Manager.

Océ Remote Logic® enables you to:
■ View system status (Océ System Control Panel).
■ Manage print jobs (Océ Queue Manager).
Change settings (Océ Settings Editor).

Océ TDS400 options

By default, the Océ TDS400 has an automatic 1 roll unit and is equipped with
a receiving tray as the output delivery device. The receiving tray is the rack on
the bottom of the printer (see figure 1 on page 12).

Automatic 2-roll unit The Océ TDS400 is available with an automatic 2-roll
unit. Each of the rolls can be loaded with print material of a different size or
type. The size and type of the available media are indicated on the operating
panel.

Compact Output Stacker The optional compact output stacker offers a smart
and efficient disposition of printed or copied drawings (up to 100 prints) on
PPC material and some other materials.

Output Delivery Tray Collects output at the rear of printers as they are printed.

Folder folds the output and adds reinforcement strips with optional
reinforcement unit.

Note: you can only use the output delivery tray or the folder.
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[2] Output Delivery Tray and Integrated Receiving Tray

Graphical User Interface The Graphical User Interface (GUI) consists of a
screen, a mouse, a keyboard and software. You use the screen, mouse and
keyboard to interact with the graphical user interface of the controller. With the
GUI you can perform Key Operator and System Administrator tasks in a
graphical way. Settings are visible within one window so that it is much easier
to view and change them.

Océ Scan Logic® Enables you to scan a document to file for later (re)use. You
can use the files in other applications or print them out.

■ Océ Scan Manager with Océ View Station LT
The Océ Scan Manager is an application available only locally on the
controller. With the Océ Scan Manager you can:
■ configure the destinations for scan-to-file jobs
■ increase your productivity with automatic file naming
■ view the scans

Refer to ‘Using the Océ TDS400 to Scan-to-file’ on page 73 for complete
information about the Scan Manager application.

Adobe® PostScript® 3/PDF The Océ TDS400 fully supports Adobe®

PostScript® 3. For Japanese 5 extra fonts are optional. They can be enabled
with a password in the Océ Settings Editor.

Océ Print Exec® Workgroup Optional software which allows you to create
and send a set of prints or drawing files to an Océ TDS printer. You can send
the settings for these jobs from your workstation, using your web browser. For
detailed information see ‘Print with Océ Print Exec® Workgroup’ on page 35.

Output Delivery Tray

Integrated
Receiving Tray
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Océ Repro Desk Océ Repro Desk is a print management solution for the
reprographer and their clients. See also ‘Print with Océ Repro Desk’ on
page 37.

Account logging An optional feature that enables you to track how many jobs
you make for a customer. This chapter describes how you use the accounting
functionality for this purpose.

Stamping An optional feature that enables you to print a predefined text on all
your copies (see ‘Stamping’ on page 68).
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Océ TDS400 users

The Océ TDS400 has the following user types:

System administrator The Océ TDS400 system administrator installs and
makes the configuration for Océ TDS400. The system administrator defines
the printer-language settings, pen settings and Automatic Language Sensing
(ALS) settings. The system administrator can help the users who need to install
the printer drivers on their workstations. See Chapter 10, ‘Printer Supplies and
Maintenance’ on page 151 for complete information. The configuration
information is in the Océ TDS400 Connectivity Manual provided with the Océ
TDS400.

Key operator The Océ TDS400 key operator is responsible for the daily
maintenance of the Océ TDS400. The key operator replenishes toner when
necessary, loads media as needed and defines the default printer settings for
recurring print jobs. Also, the key operator defines all time settings, such as
panel time out and sleep mode time out. See ‘Océ Account Center’ on
page 145 for more information.

Repro operator The repro operator is responsible for the daily operations on
the Océ TDS400. The Repro Operator settings are a subset of the Key Operator
settings. The Repro Operator has no rights to change settings in the Océ Settings
Editor. In the Océ Queue Manager and the Océ System Control Panel the repro
operator has the same user rights as the Key Operator and System Administrator.

Anonymous user Typically, an anonymous user on the Océ TDS400 can be
either a PC user who has remote access to the system through one or more
drivers (Windows® driver, AutoCAD® ADI/HDI or PostScript®) or the remote
applications (Océ Queue Manager, Océ System Control Panel and Océ
Settings Editor), or the print submission/print management applications, or a
user performing a copy job at the scanner.

Service operator The Océ TDS400 service operator is responsible for
installation and maintenance of the Océ TDS400.
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User interaction

You can operate the Océ TDS400 from different locations: local and remote:
■ Operator panels

The Océ TDS400 has two operator panels to make the settings for the print
jobs and the copy jobs. See ‘Printer operator panel’ on page 24 and ‘Scanner
operator panel’ on page 48 for complete information.

■ Océ Remote Logic®
Use the Océ Remote Logic® to make the default key operator and system
administrator settings (Océ Settings Editor). To see the status of the jobs in
the print queue you use the Océ Queue Manager. The Océ System Control
Panel shows the status of the complete system.

■ Océ Scan Logic®
With Océ Scan Manager and Océ View Station LT you can define all
important settings for scanning.

■ Printer drivers
With the Océ TDS400 one or more printer drivers can be used, including
Print Exec® Workgroup, Windows® driver, AutoCAD® ADI/HDI and
PostScript®. With these drivers PC users can access the Océ TDS400
remotely, from their applications, to print their files. More information about
installing, configuring and use of the drivers can be found in the
documentation provided with the drivers. All Océ drivers (except Postscript)
can be freely downloaded from the Web at www.oce.com.
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The data flow to the Océ TDS400

Connect the Océ TDS400 to a host environment, which can be a stand alone
Workstation or a Workstation connected to a network. It accepts different
standard format vector and raster data files from the host environment and
converts these into high quality prints (see figure 3).

[3] Data flow to the Océ TDS400

When an Océ TDS400 receives vector, raster, Adobe® PostScript® or PDF
(optional, Adobe® PostScript® 3™)data it will generate a print with the
settings as specified in the Océ Settings Editor.

Each print job has remote control commands to indicate the settings for a job.
This so called header contains the job and the file defined settings in Océ Job
Ticket (OJT). The OJT settings overwrite the settings defined in the Océ
Settings Editor. Except for pen settings and job management which have
priority over the Océ Job Ticket settings.

Application
Software

Océ TDS400

Printfile 
Print

Job
Settings

Print
File
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To compose such a header, you can:
■ Compose the header within your application. Please refer to the Océ Job

Ticket (OJT) manual.
■ Use an Windows® and/or AutoCAD® HDI driver to generate both a

printable file (e.g. HP-RTL, HP-GL/2) and the appropriate header with
RCF-commands. Please refer to the Windows® / AutoCAD® Driver
documentation.
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Chapter 2
Using the Océ TDS400 to Print

This chapter explains how to print with the Océ TDS400.
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Printer operator panel

The operator panel on the right hand side is easy to use (see Figure 4). The
panel has keys and a display.

[4] Printer operator panel

next/select

previous

on-line stop
Stop key

On-line
key

Browse
keys

Next/select
key

Previous
key

Alphanumeric display
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Display

The display shows the feedback about print job status and error messages see
page 42and page 44 in normal mode. In off-line mode it shows the ‘off-line’
menu (see Figure on page 46).

Menu level indicator

The menu level indicator indicates the current position in the menu. Press the
Previous key to scroll through the menu.

[5] Menu level indicator in the top level of the menu
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Keys

With the keys on the operator panel you can make the settings for the Océ
TDS400 Printer.

The following keys are available

Available keys
Key types Function
On-line key Press the On-line key to put the printer on-line or off-line. To ac-

tivate the program mode and to enter the top level menu. You
can use the Next/select key, the Previous key and the Browse
key to go through the menu. If the green light above the On-line
key is on, the printer is on-line; if this light is off, the printer is
off-line.

Next/select key To select an option or a setting in the menu. Or in case a
sub-menu is present, enter a menu on a lower level.

Previous key Press this key to go one level higher in the menu.
Browse keys These two keys are used to select another mode at the same level

of the menu, or to display the next or previous option from the
option list.

Stop key The red Stop key is used to stop the current print job.
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How to turn on and turn off the Océ
TDS400 printer

To turn on the system:
■ turn on the printer.
■ turn on the scanner (see page 53).
■ turn on the controller(see page 28).

When you turn on the system, it is ready for operation. In this state, the
machine is in the stand-by mode.

If the system is not in use for more than 1 minute, the operator panel returns
automatically to the stand-by mode. The operator panel of the scanner is
activated in the following conditions:
■ you feed an original
■ a key on the operator panel is pressed

▼ Turn on the printer

1 Set the ON/OFF switch at the rear of the printer to position ‘1’ (see Figure 6).
If the power supply is connected, the green switch lights.

[6] On/off switch of the printer

Note: When ‘Ready’ is displayed on the operator panel, the printer is ready for
use.
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▼ Turn off the printer

1 Set the ON/OFF switch at the rear of the printer to position ‘0’ (see Figure 4).

Attention: If you switch off the printer during a print job, it is possible that
you lose information or that a paper jam occurs.

▼ Turn on the controller

1 Press the key on the front of the controller.

▼ Turn off the controller

1 Select the ‘Shut down’ option from the Océ System Control Panel. You can do
this through both the controller and through Océ Remote Logic®.

2 Switch off the controller and the monitor.

Cancel a print

Cancel a print before you start the print or during the print.

▼ Cancel a print

1 Press the Stop key.
The printer stops.
When the printer runs, the paper is cut.
The paper is always ejected.
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Menu structure

On the Océ TDS400 printer operator panel, you can do a number of actions.
These actions include:
■ Media settings (material and size).
■ Print info (configuration report, menu card and demo print).
■ Configuration (connectivity issues).
■ System (clear set memory and diagnostic mode).

Media type and size on the printer

One of the features of the Océ TDS400 printer is the automatic media change
function. This function allows the printer to take another roll of the same
format and copy material when the roll becomes empty when you print. You
must configure this setting in the Océ Settings Editor (see ‘Océ Power Logic®:
The Settings Editor’ on page 99).

If you activate this function the machine automatically switches to the other
roll, if the used one becomes empty. The switch only occurs if the kind of
media and the width of the material is the same for both rolls.

Note: The Océ TDS400 Printer can not identify the copy material type and
format. Fill the media and indicate the type and the size as described in
Chapter , ‘Media’ on page 152.

See ‘List of available material types and sizes’ on page 214 for a summary of
all materials for the use with the Océ TDS400 Printer.

If you insert a new roll with another material or with a different width, you
have to program the new roll specifications. Refer to ‘List of available material
types and sizes’ on page 214.

Note: The machines switches automatically to the other roll if the used roll
becomes empty, if you activate this function in the Océ Settings Editor.
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▼ Set the media width settings

1 Press the On-line key to put the printer off-line.
2 Select the ‘Media settings’ item with the or key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Roll 1’or ‘Roll 2’ with the or key.
5 Press Next/select to enter the ‘Roll’ or ‘Manual feed’ menu.
6 Select the ‘Width’ item with the or key.
7 Press Next/select to enter the ‘Width’ menu.
8 Select the desired width with the or key.
9 Press Next/select to confirm the selected width.

10 Press On-line to put the printer on-line again.

▼ Set the media type settings

1 Press the On-line key to put the printer off-line.
2 Select the ‘Media settings’ item with the or key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Roll 1’, ‘Roll 2’, ‘Manual feed’ with the or key.
5 Press Next/select to enter the ‘Roll’ or ‘Manual feed’ menu.
6 Select the ‘Material’ item with the or key.
7 Press Next/select to enter the ‘Material’ menu.
8 Select the desired media material with the or key.
9 Press Next/select to confirm the selected media material.

10 Press On-line to put the printer on-line again.
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Manual feed

There are two possibilities to select manual feed:
■ via remote control commands added to the print file (by means of Plot

Director or drivers).
■ choose ‘manual feed’ on the scanner operator panel.

[7] Manual feed

If you want to use manual feed, you must:
1 program the media settings (material and feed time out) on the printer
2 send the file
3 feed the sheet of material
4 hold the material until the printer pulls in the first part of the material.

If you select manual feed, the printer will inform you to feed the sheet into the
printer. There is a time out between 1 and 10 minutes. Default is 1 minute.

▼ Set the time-out for manual feed

Default is 1 minute.

1 Press On-line to put the printer off-line.
2 Select the ‘Media settings’ item with the or key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Manual feed’ with the or key.
5 Press Next/select to enter the ‘Manual feed’ menu.
6 Select the ‘Time out’ with the or key.
7 Press Next/select to enter the ‘Time out’ menu.
8 Select the desired time out with the or key.
9 Press Next/select to confirm the selected time-out.

10 Press On-line to put the printer on-line again.
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Cut media

If the material does not have a straight leading strip, you can cut the material
at right angles from the roll.

▼ Cut the material from roll 1 or roll 2

1 Open the drawer.
2 Feed the paper manually until it is 5 cm above the top drawer.
3 Press the On-line key to put the printer off-line.
4 Close the paper drawer.
5 Select the ‘Media settings’ item with the or key.
6 Press Next/select to enter the ‘Media settings’ menu.
7 Select ‘Cut media’ with the or key.
8 Press Next/select to cut the paper.
9 Open the paper drawer.

10 Remove the scrap of material.
11 Feed the material until you can see the material and put the material into

position (see Figure 61 on page 155) and (see Figure 65 on page 157).
12 Close the drawer.
13 Press the On-line key to put the printer on-line again.
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Print info

You have the possibility to print:
■ the configuration report
■ the menu card
■ a demo plot

Print the configuration report

The configuration report shows the configuration and the settings of the
system.

▼ How to print the configuration report

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the or key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Configuration’ item with the or key.
5 Press Next/select to print the configuration report.
6 Press On-line to put the printer on-line again to print the report.

Print the menu card

You can print the menu of the printer, to guide you through the menu.

▼ How to print the menu card

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the or key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Menu card’ item with the or key.
5 Press Next/select to print the menu chart.
6 Press On-line to put the printer on-line again to print the menu card.
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Print the demo print

After the installation of the Océ TDS400, you can print the demo print, to
check the printer and the controller.

▼ Make a demo print

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the or key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Demo print’ item with the or key.
5 Press Next/select to print the demo print.
6 Press On-line to put the printer on-line again to print the demo print.
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Print with Océ Print Exec® Workgroup

Introduction

Océ Print Exec® Workgroup is an optional print job submission application
which allows you to send print jobs to the Océ TDS400 through your web
browser. Enable Océ Print Exec® Workgroup with a password in the Océ
Settings Editor. Océ Print Exec® Workgroup allows you to do the following.

1 Select and collect the files to print (documents and drawings), in a print job.
2 Configure the print job.
3 Preview the files to print.
4 Submit the print job.
5 Check the print job and the printer configuration status.

Options

Océ Print Exec® Workgroup has the following options.

■ View status information about the printer configuration and available media.
■ View status information of submitted print jobs in the historic queue.
■ Set the document or drawing settings.
■ Set the job settings for a print job.
■ Add a settings configuration for a print job.
■ Add a maximum of 100 documents or drawings to a print job.
■ Add documents or drawings from the Océ Doc Exec® archive.
■ Add a stamp to the document or drawing.
■ Add a banner to the print job.
■ Preview the document or drawing before you print.
■ Save and retrieve print jobs.
■ Submit print jobs to printer queue or inbox queue.
■ Manage serveral print jobs.
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Connect to Océ Print Exec® Workgroup
Requirements for the browser software and network. ■

■ Microsoft® Internet Explorer® 5.0 or higher versions, or
■ Netscape Navigator® 6.0 or higher versions.
■ TCP/IP network which connects the printer and the end user workstation.

▼ How to connect to Océ Print Exec® Workgroup

1 Enable Océ Print Exec® Workgroup in the Océ settings editor.

2 Enter the following link URL in you browser: http://printer name.
When you enter the URL for the first time, the required software is installed
automatically at your workstation.

The documentation set

The complete documentation set of Océ Print Exec® Workgroup includes the
following.

■ The Océ Print Exec® Workgroup user manual
■ On-line help files in the Océ Print Exec® Workgroup application.
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Print with Océ Repro Desk

Introduction

Océ Repro Desk is the preferred print management solution for reprographers.
Océ Repro Desk consists of the following two parts.

■ Océ Repro Desk Remote software which facilitates the electronic
submission of drawing files and print request from the clients to their
reprographers.

■ Océ Repro Desk Server which provides the reprographers with extensive
print management and accounting functions to maximise the productivity of
their print equipment assets.

The documentation set

The complete documentation set of Océ Repro Desk includes the following.

■ The Océ Repro Desk user manual
■ The on-line help files in the Océ Repro Desk applications.
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Configuration

Select a language

On the operator panel of the Océ TDS400 Printer you can indicate which
language you use to display the printer information, like status and error
messages.

▼ Select a language

1 Press the On-line key to put the printer off-line.
2 Select the ‘Configuration’ item with the or key.
3 Press Next/select to enter the ‘Configuration’ menu.
4 Select ‘Language’ with the or key.
5 Press Next/select to enter the ‘Language’ menu.
6 Select the desired language with the or key.
7 Press Next/select to confirm the selected language.
8 Press On-line to put the printer on-line again.
9 Turn the printer ‘off’ and ‘on’ again.

Network settings

The Océ TDS400 has 2 network adapters. To set the network settings you must
enter the network data in 4 fields.
■ Use DHCP server. The Dynamic Host Configuration Protocol (DHCP) is a

protocol to automate the assignment of Internet Protocol (IP) addresses in a
network. Without DHCP, the IP address must be entered manually.

■ IP address. An IP address has two parts: one part identifies the network (with
the network number) and the other part identifies the specific machine or host
within the network (with the host number).

■ Subnetmask. A subnet (short for ‘subnet work’) is an identifiably separate
part of an organization's network. To manage routing that could and should
be handled within an organization.

■ Set default gateway A gateway is a network point that acts as an entrance to
another network.

Press the following key sequence to enter the System menu on the printer to set
the network settings.
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▼ Enter the System menu

1 Press arrow left ( ).
2 Press the Stop key.
3 Press arrow right ( ).
4 Press the Stop key.
5 Press arrow left ( ).
6 You can now enter the System menu.

▼ Set use DHCP server

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the or key.
3 Press Next/select to enter the ‘System’ menu.
4 Select ‘Network sett.’ with the or key.
5 Enter password.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the or key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Use DHCP server.’ with the or key.

10 Select ‘Yes’ or ‘No’ with the or key.
11 Press Next/select to confirm.
12 Press On-line to put the printer on-line again.

▼ Set the IP address

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the or key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the or key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the or key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘IP address’ with the or key

The first three digits flash.
10 Enter the first three numbers of the ‘IP address’ with the or key.
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘IP address’ with the or key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘IP address’ with the or key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘IP address’ with the or key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.
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▼ Set the Subnetmask

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the or key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the or key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the or key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Subnetmask’ with the or key

The first three digits flash.
10 Enter the first three numbers of the ‘Subnetmask’ with the or key.
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘Subnetmask’ with the or key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘Subnetmask’ with the or key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘Subnetmask’ with the or key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.

▼ To set the Default gateway

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the or key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the or key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the or key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Default gateway’ with the or key

The first three digits flash.
10 Enter the first three numbers of the ‘Default gateway’ with the or key.
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘Default gateway’ with the or key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘Default gateway’ with the or key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘Default gateway’ with the or key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.
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Paper series

You must enter the paper series that you use in the printer. Choose between:
■ DIN
■ DIN CARTO
■ Only 8.5 inch
■ Mix 8.5/9 inch

▼ To set a paper series

1 Press the On-line key to put the printer off-line.
2 Select the ‘Configuration’ item with the or key.
3 Press Next/select to enter the ‘Configuration’ menu.
4 Select ‘Paper series’ with the or key.
5 Press Next/select to enter the ‘Paper series’ menu.
6 Select the required paper series with the or key.
7 Press Next/select to confirm.
8 Press On-line to put the printer on-line again.

Clear set memory

The set memory indicates the available memory. If an error occurs, for example
the set memory reaches its limits, you must clear the set memory.

▼ Clear set memory

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the or key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter the password to get access.
5 Select the ‘Clear setmem’ item with the or key.
6 Press Next/select to enter the ‘Clear setmem’ menu.
7 Select ‘Yes’ or ‘No’ with the or key.
8 Press Next/select to confirm the setting.
9 Press On-line to put the printer on-line again.

10 Turn ‘off’ and ‘on’ the controller.

Diagnostic mode

The Diagnostic mode is only meant for the Océ service technician.
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Status messages

Status Messages
Status messages Explanation
Off-line The printer is off-line.

Change options.
Reset printer Turn the printer off and turn the printer on.
Connecting..... There is no communication between the controller and the printer.

Wait until there is communication.
Printer asleep The printer is in low power mode.

The energy is saved.
Please wait The printer downloads the language.

Wait until the printer is prepared to operate.
Printer ready The printer is prepared to print.
Preparing job The printer prepares a print or copy job.
Printing The printer prints.
Load roll 1
A2
Paper

The printer detects that the required media is not available on roll
1.
Fill roll 1 with the indicated media.

Load roll 2
A2
Paper

The printer detects that the required media is not available on roll
2.
Fill roll 2 with the indicated media.

Manual feed
A2
Paper

The printer detects that the required media is not available in the
manual feed.
Put the required media in the manual feed.

Open left cover
Refill toner
Press <on-line>

The toner container is empty.
Refill the toner container.

Conditioning The machine improves the print quality by optimising the
toner concentration.
Wait until the toner concentration is at the correct level.

Printer ready
Roll 1 empty

The paper roll 1 is empty.
Reload roll 1.

Printer ready
Roll 2 empty

The paper roll 2 is empty.
Reload roll 2.

Printer running
Roll 1 empty

The paper roll 1 is empty.
Reload roll 1 after the printers stops printing.

Printer running
Roll 2 empty

The paper roll 2 is empty.
Reload roll 2 after the printers stops printing.

Job canceled The current print or copy job is canceled
Close roll unit The roll unit is open.

Close the roll unit.
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Sensor not free
Remove paper
Press <on-line>

The paper of one of the rolls is transferred after the marker (see
‘Feed the material’ on page 155) when power is applied to the
printer.
Take the paper back.
Press <on-line>

Paper retracted
Press <on-line>

Put the paper into the manual feed.
Press <on-line>

Copy too short
Remove paper
Press <on-line>

The length of the print material is less than 420 mm. This can oc-
cur with the manual feed.
Use an original longer than 420 mm.

Inputflap open
Close inputflap

The input flap is open.
Close the input flap.

Inputflap open
Remove paper
Press <on-line>

The input flap is open during the print process
Remove the paper and press <on-line>.

Roll 1 empty
Open roll unit

The paper on roll 1 is empty.
Open the roll unit and replace it.

Roll 2 empty
Open roll unit

The paper on roll 2 is empty.
Open the roll unit and replace it.

Wait for folder The communication between the printer and the folder starts up.
Folder is off The communication between the printer and the folder was not es-

tablished.
Folder belt full The belt of the folder is full.

Empty the belt of the folder.
RU tape empty The tape roll of the reinforcement unit is empty.

Open the reinforcement unit and replace the empty tape roll.

Status Messages (continued)
Status messages Explanation
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Error messages

Error messages
Error messages Explanation
Copy too late
Remove paper
Press <on-line>

The copy is too late at the paperpath output sensor
Remove the print material.

Speed failure
Remove paper
Press <on-line>

A paper jam occurred.
Remove the paper jam and press <on-line>

Knife 1 error
Remove paper
Press <on-line>

An error occurred during the cut of the roll.
Check the paper in the roll unit and remove if necessary.
Press <on-line>.

Knife 2 error
Remove paper
Press <on-line>

An error occurred during the cut of the roll.
Check the paper in the roll unit and remove if necessary.
Press <on-line>.

Roll retract err
Press <on-line>

Print material error when the roll unit takes back the material.

Roll init error
Open roll unit
Press <on-line>

A sensor of the roll unit is activated when power is applied to the
printer.
Open the roll unit.
Guide the paper to the marker (see ‘Feed the material’ on
page 155.
Press <on-line>

Input too late
Open roll unit
Press <on-line>

The input sheet is too late.
Open the roll unit
If necessary, withdraw roll and rewind
Press <on-line>

Deposit error
Press <on-line>

An error in the compact output stacker occurred.
The compact output stacker stops.
The print process continues.
Press <on-line>.

Illegal language on
controller
using UK English
Press <on-line>

The controller has an illegal language.
The controller uses the English language instead of the selected
language.
Call service.
Press <on-line>

Close roll unit
Rewind paper
Press <on-line>

While you printed, the roll unit opened.
Rewind the paper.
Close the roll unit.
Press <on-line>
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Error 1st fold A paper jam occurred in the first fold section of the folder.
Clear the paper jam.
Press <on-line>

Error in folder A tape jam occurred in the reinforcement unit or a paper jam oc-
curred in the folder. A paper jam can occur in the transport section
of the folder or in the reinforcement unit of the folder.
Clear the tape jam or clear the paper jam.
Press <on-line>

Error 2nd fold A paper jam occurred in the second fold section of the folder.
Clear the paper jam.
Press <on-line>

Wrong format The folder detected a paper format other than specified at the
printer operator panel.
Correct the format the printer operator panel.
Press <on-line>

Error messages (continued)
Error messages Explanation
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Menu structure of the printer

When you browse through the tree, the left items are displayed on top. The
upper items are displayed first.

A0 (841x1189mm)
A1 (594x841mm)
A2 (420x594mm)
A3 (297x420mm)
B1+ (700x1000mm)
B2+ (500x700mm)
B1 707x1000mm)

Width B2 (500x707mm)
E (34x44”)
D (22x34”)
C (17x22”)
B (11x17”)

Roll 1 E+ (36x48”)
D+ (24x36”)
C+ (18x24”)

Roll 2 B+ (12x18”)
30x42”

Media settings Paper 64g
Paper 75g

Transparent 75 g
Transparent 90 g

Material Transparent 110g
Vellum

Material Film 3.5
Film 4.5

Manual feed Translucent

Time out 67 seconds

Cut media Cutting...

Configuration Printing...

Print info Menu card Printing...

Demo print Printing...

UK English
Language Nederlands

more...
Configuration

DIN
Paper series DIN CARTO

ONLY 8.5”
MIX 8.5/9”

Clear setmem Yes
No

System Enter
password

Diagnostic
mode

Yes

No

Use DHCP
server

Yes

No

Network sett. adapter 1 IP address 123.456.789.123

Subnetmask 123.456.789.123

Default
gateway

123.456.789.123

Use DHCP
server

Yes

No

adapter 2 IP address 123.456.789.123

Subnetmask 123.456.789.123

Default
gateway

123.456.789.123

Installation Enter password start install.

Stacker
Delivery First Fold

Belt

TrailingLegend
Leading

Input

Standard
Method Afnor

Ericsson

Off
Binding On

Reinforce

Binding edge (15 .. 30)

Package Length (276..310)
Width (186..230)

Clean RU knife Cleaning RU...

Folding
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Chapter 3
Using the Océ TDS400 to Copy

This chapter contains a description how to copy with the
Océ TDS400.



48 Océ TDS400 User Manual

Scanner operator panel

Define the settings with the scanner operator panel. The display gives you the
feedback and the available menu options.

.

[8] Scanner operator panel

+-start cancel

stripexposure

input output extra

set file

zoom

sheet copy

leading

trailing

roll 1

roll 2

manual

media

Input key Extra keyOutput
key

Alphanumeric
display

Browse keys

Confirm
key

Strip key

Copy quantity
display

Cancel key

+ key

Zoom key

Exposure
key

- key

Start key

Media key
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The keys
The Input key Select a single original or a set of originals.

The Output key Select copy or file (scan-to-file) as your output.

The Extra key This key allows you to enter the Extra mode of the scanner and
return to the normal mode. Set the properties for the original, the scanned files
and for the scanner in the Extra mode.

The Browse keys (left , right ) Move in one level of the menu structure as
shown in the display. Browse the preset zoom values.

The Browse keys (up , down ) Move between the levels of the menu
structure as the display shows. Adjust the zoom value with an accuracy of 1
percent.

The Confirm key Confirm the current setting in the menu structure. If you
press the confirm key a second time in the current menu item, you restore the
previous setting.

The Strip key Press this key to add or to remove a ‘leading’ or a ‘trailing’ strip.
The icon flashes. Use the browse keys (left , right , up , down ) to change
the value. The icon remains on if you press another settings key and select a
different value than the default value.

The Cancel key Press this key one time to set the copy counter to the default
value. Press this key twice to change all settings to their default values. The
scan stops if you press this key.

The - and + keys Change the number of copies.

The Start key Press the green start key to start the scan or to restart the
copy process.

The Zoom key Enters the zoom mode. The icon flashes. Use the browse keys
(left , right ) to browse the preset zoom values. Use the browse keys (up ,
down ) to adjust the zoom value with an accuracy of 1 percent.

The Exposure key enters the exposure mode. The icon flashes. Use the browse
keys to change the exposure value.

The Media key Select roll 1, roll 2 or manual feed. The equivalent icon is on.
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The display

The display shows the feedback about the scan job status (see table below) in
normal mode. In off-line mode it shows the off-line menu (see page 71) and
(see page 82))

.

Status messages
Status Messages Explanation
Scanner ready The scanner is prepared to scan.

+ = add
= close

Add an original to the set and press the Start key .
After the last scan of the set, remove the original and press
the Start key to close the set.

Connecting..... There is no communication between the controller and the
scanner.
Wait until the there is communication.

Scanner asleep The scanner is in low power mode.
Scanner running The scanner scans.
Please wait The scanner downloads the languages.
Remove original
Press <cancel>

There is an original on the table while you turn on the scan-
ner.
The message appears if you pressed the Cancel key while
you scan.
Remove the original.
Press cancel.

Original too long
Press <cancel>

Use an original shorter than 15 meter.

Wrong orig. type
Press <cancel>

This message shows when you select ‘Background compen-
sation’ and ‘Blueprint’ as original.
Press cancel.

Set closed You closed the copy set.
Reset scanner Turn the scanner on and off.
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Menu level indicator

The menu level indicator indicates the current position in the menu. Press the
Previous key to scroll through the menu.

[9] Menu level indicator on the scanner operator panel

input output extra

set file

sheet copy
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Copy jobs

Your printer system has a 1 roll or 2 roll unit. Use the Media key, on the scanner
operator panel, to select a roll, or to select the manual feed on the printer.

Note: You must set the media type on the printer.

You can make 1:1 copies and you can decrease or increase your original from
25% to 400%. You can set the zoom value in fixed steps or in% steps. The
default zoom is set in the Océ Settings Editor.

The Océ TDS400 cuts the paper to the length of the original, the synchro cut.
If you select the standard cut mode, the copy is cut at a standard length, (see
‘Set synchro or standard cut’ on page 64).

The automatic exposure gives background-free copies from most
line-drawings. Select the correct original type if you have an extremely dark or
light original, or an original with pasted parts or photographs (see ‘The
exposure settings’ on page 58).

With the Océ TDS400 you can do a number of basic tasks. These tasks include:
■ Turn on, turn off the scanner
■ Make copies
■ Select the required media
■ Select the manual feed
■ Specify the zoom factor
■ Select the exposure setting
■ Select to add or remove a strip
■ Select the input mode
■ Select the output mode
■ Select extra settings
■ Deliver originals after scanning
■ Define settings for the next original
■ Select autofeed of the original
■ Stop a copy job
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You can also do a number of special copy jobs. These special copy jobs
include:
■ Copy non standard size originals
■ Define the copy size
■ Define image quality: Optimisation for line/text/photo or blueprint mode
■ Background compensation for line/text/photo or blueprint mode
■ Edit function: mirror

Turn on and turn off the Océ TDS400 scanner

To turn on the system:
■ turn on the scanner.
■ turn on the printer (see page 27).
■ turn on the controller(see page 28).

When you turn on the system, it is ready for operation. In this state, the
machine is in the stand-by mode. There is no need to turn it off after each copy
job. You can leave the system turned on for the rest of the day. At all times, the
Océ TDS400 is ready to use.

If the system is not in use for more than 1 minute, the operator panel returns
automatically to the stand-by mode. The operator panel of the scanner is
activated in the following conditions:
■ you feed an original
■ a key on the operator panel is pressed

▼ Turn on the scanner

1 Set the ON/OFF switch at the rear of the scanner, to position ‘1’ (see
Figure 10). If the power supply is connected, the green switch lights.

[10] On/off switch of the scanner
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Note: The system is ready to use. You can turn ON and OFF the scanner
separate from the printer and without any particular order.

▼ Turn off the scanner

1 Set the on/off switch at the rear of the scanner, to position ‘0’ (see Figure 10).

Start the copy process

If you press the Start key, and you do not change any settings, the settings of
the previous copy job are used or the default settings of the machine are used:
■ number of copies 1
■ use roll 1
■ zoom 100%
■ synchro cut
■ no leading or trailing strip
■ auto exposure on; exposure setting 0.

Default settings are used in the following situations:
■ after turn on
■ after you press ‘cancel’ twice
■ after a time-out of 1 minute (since the end of previous copy job has expired).

If the Start key is pressed the original will be scanned. The original returns to
the operator if you have enabled the rewind function (see page 60). You can
make settings for the next job.

When the original returns, remove the original. A new original can be fed and
you can program new settings.

Make copies
The copying process starts when you press the Start key. Before you press the
Start key, you can change the settings.

▼ Feed the original

1 Insert the original face down and right aligned, along the original guide line on
the scanner feed table so that you can see the line (see Figure 11).
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[11] Insert the original

The original will be transported about 1 centimetre to a defined position.
2 Specify the number of copies with the ‘+’ or ‘-’ keys.
3 Press the ‘media’ key to select a roll or to select ‘manual feed’.
4 Press the ‘input’ key to specify how a job is sorted: ‘sheet’ (output 1-1, 2-2,

3-3, or ‘set’ (output 1-2-3, 1-2-3).
5 Press the ‘zoom’ key to specify a reduction or an enlargement factor, if needed.
6 Press the ‘exposure’ key to correct for a lighter or darker original, if needed.
7 Press the ‘strip’ key to add or remove a strip, if needed.
8 Press the green Start key to start the copy job. The original is fed into the

scanner. The printer starts.
9 Collect your output.

If you make a copy within the time-out of 1 minute, the machine will use the
settings of the previous copy job.

Number of copies

To have multiple copies from one original, enter the number of copies on the
scanner operator panel. The original is scanned just once and the required
number of copies are processed.

Refer to ‘Product specifications Océ TDS400’ on page 209 for the limitation
of multiple copy jobs.
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▼ Select the number of copies

1 Enter the number of copies (1 up to 99) with the ‘+’ or ‘-’ key on the scanner
operator panel.
The display shows the number of copies.

Select the use of roll 1 or roll 2 or manual feed

You can select between two rolls or manual feed with the ‘media’ key. When
a roll is selected, the copy material is taken from the selected roll.

Note: Only use paper as specified in ‘List of available material types and sizes’
on page 214.

▼ Select roll 1, roll 2

1 Press the ‘media’ key until the indicator that matches your selection lights.
2 Enter the media width if you have selected ‘Manual feed’ (see ‘Media type and

size on the printer’ on page 29).
3 Set the correct media type settings (see ‘Set the media type settings’ on

page 30).
4 Press the confirm key.
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Select the input mode

You can use the ‘Input’ setting to indicate how a job is sorted: the ‘sheet’
option prepares each sheet as a separate job (see Figure 12).

Select ‘set’ to keep the copies together and to prevent the interruption with a
print job. ‘set’ makes a copy for each sheet in a set and continues with the next
copy of the complete set (see Figure 12).

:

[12] Difference between the ‘sheet’ option and the ‘set’ option

▼ Select the input mode

1 Press the ‘input’ key to select the input mode ‘sheet’ or ‘set’.
The selected indicator lights.

To copy sets

Use the input mode ‘set’ to copy sets of originals. The originals will be scanned
sheet by sheet and the image information will be stored in memory. When you
press the Start key to close the set the printer prints the output.

▼ How to copy sets

1 Press the ‘input’ key to select the input mode ‘set’.
2 Insert an original.
3 Add the originals to the set and press the Start key .
4 After the last scan of the set, remove the original and press the Start key to

close the set.

page 1
page 1
page 1
page 2
page 2
page 2
page 3
page 3
page 3

page 1
page 2
page 3

page 1
page 2
page 3
page 1
page 2
page 3

Output with the input mode ‘sheet’ Output with the input mode ‘set’.

Print 3 copies of a 3 - page document
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Specify the zoom factor

With the Océ TDS400 you can reduce or enlarge your original from 25% to
400%. Press the ‘zoom’ key to enter the zoom mode. You can select the zoom
factor by means of the ‘browse’ keys when the indication flashes.
Choose between the fixed step zoom mode by means of the right and left
browse keys. In fixed steps mode 8 pre-set zoom settings are available. Choose
the% zoom mode by means of the up and down browse keys.

Note: You can configure the fixed zoom steps in the Océ Settings Editor. Also
refer to ‘Summary of standard zoom formats’ on page 218.

▼ Select the zoom factor with pre-set zoom steps

1 Press the ‘zoom’ key. The indicator flashes.
2 Specify the zoom ratio with the or key.

The display shows the selected ratio. If you make the adjustments with this key,
one of the indications above the key flashes. If the adjustment is different from
the default setting, the indication lights.

▼ Select the zoom factor with 1% zoom steps

1 Press the ‘zoom’ key. The indicator flashes.
2 Specify the zoom ratio with the or key.

The display shows the selected ratio. If you make adjustments with this key,
one of the indications above the key flashes. If the adjustment is different from
the default setting, the indication lights.

The exposure settings

You can modify the exposure quality to improve the image quality. To modify
the exposure you can choose between:
■ use of the lighter and darker keys
■ enable or disable automatic background compensation
■ adjust the Océ Image Logic® based on the original type you want to copy

The default exposure settings makes background-free copies of most line
drawings. The automatic background compensation is activated. The
background is measured when you scan an original. The result of some
originals can not match your requirements.
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When you copy very light or dark originals, or originals with unequal
background density, the result can not meet your requirements (e.g. too much
background).

Default the automatic background compensation is active and the exposure
level is 0.

The automatic background compensation will provide a good quality copy
from a large variety of originals. The automatic background compensation
setting, which is switched on (by default), ensures the production of
background-free copies of most line drawings.

▼ Adjust the exposure setting

1 Press the ‘Exposure’ key.
2 Select the needed exposure value with the or key.

▼ Set the automatic background compensation

1 Press the Extra key.
2 Select ‘Original’ with the or key.
3 Press the key to enter the ‘Original’ menu.
4 Select ‘Background comp.’ with the or key.
5 Press the key to enter the ‘Background comp. menu.
6 Select ‘on’ or ‘off’ with the or key.
7 Press the confirm key.

The Océ TDS400 allows you to adjust the exposure setting according to the
type of image on the original. There are three original types available:
■ Lines/text
■ Photo
■ Blueprint

By default ‘Lines/text’ is selected with the background compensation enabled.
This is the best setting for originals with characters and line art.
■ Select ‘Photo’ when the original consists of a combination of characters, line

art and picture images.
Note: If you select ‘Photo’, the ‘Background compensation’ will be
switched off automatically.
■ Select ‘Blue print’ when you want to copy an original with an image in

negative (image in white on dark background). The copy will be positive
(image in black on white background).
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▼ Improve the copy quality according to the type of image

1 Press the Extra key.
2 Select ‘Original type’ with the or key.
3 Press the key to enter the ‘Original type’ menu.
4 Select ‘Lines/text’, ‘Blueprint’ or ‘Photo’ with the or key.
5 Press the key to enter the ‘Lines/text’, ‘Blueprint’ or ‘Photo’ menu.
6 Select the needed original type.
7 Press the confirm key.

Deliver originals after scanning

You can choose for delivery of the original at the front (rewind) or the rear side
of the scanner. Use the output at the rear side of the scanner if your originals
are:
■ thick
■ very thin
■ damaged
■ in a carrier sheet.

The rewind setting will return to default when,
■ the ‘cancel’ key is pressed,
■ the panel time out has exceeded.

▼ Enable the rewind function

1 Press the Extra key.
2 Select ‘Scanner’ with the or key.
3 Press the key, to enter the ‘Scanner’ menu.
4 Select ‘Rewind original’ with the or key.
5 Press the key, to enter the ‘Rewind original’ menu.
6 Select ‘on’ or ‘off’ with the or key.
7 Press the ‘confirm’ key.

Enable automatic feed of the original
To increase the productivity enable Automatic feed, no need to press the Start
key, except for the first original. If you disable automatic feed you must press
the Start key.
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▼ To enable automatic feed

1 Press the Extra key.
2 Select ‘Scanner’ with the or key.
3 Press the key, to enter the ‘Scanner’ menu.
4 Select ‘Autofeed orig.’ with the or key.
5 Press the key, to enter the ‘Autofeed orig.’ menu.
6 Select ‘on’ or ‘off’ with the or key.
7 Press the ‘confirm’ key.

Define settings for the next original

For each original you need to copy you can specify new settings.

▼ Define settings for the next copy job

1 Select all the needed settings for the next original.
2 Insert the next original.

Copy on pre-cut sheets

If you copy a job on a media type and/or size that is not available on one of the
paper rolls, you can manually feed sheets instead of reloading paper rolls. You
can insert pre-cut copy material in this slot, one sheet at a time. To set the time
out for manual feed refer to ‘Set the time-out for manual feed’ on page 63.

▼ Copy on pre-cut sheets

1 Enter the type of the copy material on the printer operator panel.
2 Press the ‘media’ key on the scanner panel to select ‘manual feed’. The

indicator lights up.
Note: The minimum length of the print material must be 420 mm.
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[13] Manual feed

3 Enter the number of copies.
4 Select the copy size.
5 Feed the original.
6 Press the Start key .
7 Take your sheet of copy material to the side of the printer that contains the

cassette tray (see Figure 13).
8 Align the copy material with your hands to the format indication and the label

on the manual feed table.
9 Move the copy material forward in the cut of the roller. A paper bulge must

appear over the full width of the page.
10 Hold the paper with your hands until the printer pulls in the first part of the

sheet.
The bulge decreases or disappears. After a few seconds, the printer pulls the
complete sheet.
Note: If the copy job requires more sheets, the display indicates to feed the
next sheet.

11 Repeat the steps 7 to 10 to complete the job.
12 Collect your output.

Note: The printer prints the image on the side of the sheet which is facing up.

Attention: When you feed a sheet of material in the manual feed while a
normal print job runs, a media jam can occur.
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▼ Set the time-out for manual feed

Default is 60 seconds.

1 Press ‘on-line’ on the printer operator panel, to enter the main menu.
2 Select the ‘media settings’ item with the or key.
3 Press ‘next/select’ to enter the ‘media settings’ menu.
4 Select ‘manual feed’ with the or key.
5 Press ‘next/select’ to enter the ‘manual feed’ menu.
6 Select the ‘time out’ with the or key.
7 Press ‘next/select’ to enter the ‘time out’ menu.
8 Select the desired time out with the or key.
9 Press ‘next/select’ to confirm the selected timeout.

10 Press ‘on-line’ to leave the main menu.
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Stop a copy job

Press the ‘cancel’ key to interrupt the original transport.

▼ Stop a job

1 Press the ‘cancel’ key.
The original transport is stopped.

2 The message ‘Remove original’, ‘Press cancel’ appears on the scanner display.
3 Open the scanner cover and remove the original.
4 Close the cover.
5 Press the ‘cancel’ key. The message disappears on the scanner display.

Set synchro or standard cut

In synchro cut mode, the copy is cut at the length of the original. The length
depends on the zoom factor and the leading or trailing strip setting. The default
is Synchro cut mode.

In standard cut mode, the copy is cut at a standard format length (portrait). You
select the length of the standard format with the ‘browse’ keys.
Example: select 36 inches, means select a format of 36 inches width and a
corresponding 48 inches length. Independent of the roll width, the material is
cut at a length of 48 inches.

When you select standard cut, the system always cuts at the selected length. If
the original length is shorter or longer than the selected length, the cut is made
at the selected length.

▼ Select synchrone cut

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press key, to enter the ‘Paper copy’ menu.
4 Select ‘cut length’ with the or key.
5 Press key, to enter the ‘cut length’ menu.
6 Select ‘on’ or ‘off’ with the or key.
7 Press the ‘confirm’ key.
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▼ Select standard cut

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press key, to enter the ‘Paper copy’ menu.
4 Select ‘cut length’ with the or key.
5 Press key, to enter the ‘cut length’ menu.
6 Select a standard paper format with the or key.
7 Press the ‘confirm’ key.

Adjust the leading or the trailing strip

To increase the copy length to accommodate for a filing strip select a positive
leading or trailing strip.

If you do not want the filing strip to show on the copy, select a negative leading
or trailing strip. The adjustment steps are indicated on the operator panel,
expressed in millimetres or 0.1 inches.

▼ Adjust the leading or the trailing strip

1 Press the ‘strip’ key to toggle between ‘leading’ and ‘trailing’ strip.
2 Select a positive or negative value in steps of 10 mm with the or key.
3 Select a positive or negative value in steps of 1 mm with the or key.

The length of the selected strip is shown in the display. If the adjustment differs
from the default setting, the indication lights.

Attention: If you make the strip larger than the strip on the original, you can
lose information.
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Leading and trailing strip It is possible to adjust the length of both the leading
and trailing strip to eliminate or add a filing strip. Leading and trailing strips
can be extended up to 400 mm or shortened up to 400 mm (see Figure 14).

[14] Example of adjusting the leading and trailing strip of an original

Trailing strip
-400 mm

Trailing strip
+400 mm

Leading strip
-400 mm

Leading strip
+400 mm
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Mirror-image copies

You can make a mirror-image copy of an original, as shown in the next figure:

[15] Example of a mirror-image copy

▼ To make a mirror-image copy

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Mirror’ with the or key.
5 Press the key to enter the ‘Mirror’ menu.
6 Select ‘on’ or ‘off with the or key.
7 Press the confirm key.

Release original

For originals on thinner types of media you can enable Release original. With
Release original enabled the original will be fully released after it is scanned.

1 Press the Extra key.
2 Select ‘Scanner’ with the or key.
3 Press the key to enter the ‘Scanner’ menu.
4 Select ‘Release orig.’with the or key.
5 Press the key to enter the ‘Release orig.’ menu
6 Select ‘on’ or ‘off’ with the or key.
7 Press the Confirm key.
8 Make other settings if required.
9 Feed the original.

10 Press the Start key.
The original is fully released after the scanner has completed its scan run.
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Stamping

Stamping is an Océ TDS400 option which allows you to print a predefined text
on all your copies. Enable stamping with a password in the Océ Setting Editor.
The key operator can predefine a maximum of 10 stamps in the Océ Settings
Editor (see chapter 5, ‘Océ Power Logic®: The Settings Editor’ on page 99).

You can select one stamp per original and you can select another colour, font
size, drawing method, legend edge or position. A stamp can consist of the
following parts:

■ predefined text
■ date
■ time

▼ How to select a stamp

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Stamp’ with the or key.
5 Press the key to enter the ‘Stamp’ menu.
6 Select ‘Enable’ with the or key.
7 Press the key to enter the ‘Stamp’ menu.
8 Select ‘on’ with the or key.
9 Press the Confirm key.

10 Press the key to leave the current menu.
11 Select ‘Select’ with the or key.
12 Press the key to enter the ‘Select’ menu.
13 Select a stamp with the or key.
14 Press the Confirm key.

Note: The following procedures are optional.

▼ How to change the stamp color

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Stamp’ with the or key.
5 Press the key to enter the ‘Stamp’ menu.
6 Select ‘Format’ with the or key.
7 Press the key to enter the ‘Format’ menu.
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8 Select ‘Colour’ with the or key.
9 Press the key to enter the ‘Colour’ menu.

10 Select a color with the or key.
11 Press the Confirm key.

▼ How to change the stamp size

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Stamp’ with the or key.
5 Press the key to enter the ‘Stamp’ menu.
6 Select ‘Format’ with the or key.
7 Press the key to enter the ‘Format’ menu.
8 Select ‘Size’ with the or key.
9 Press the key to enter the ‘Size’ menu.

10 Select a size with the or key.
11 Press the Confirm key.

▼ How to change the drawing method

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Stamp’ with the or key.
5 Press the key to enter the ‘Stamp’ menu.
6 Select ‘Drawing method’ with the or key.
7 Press the key to enter the ‘Drawing method’ menu.
8 Select the drawing method with the or key.
9 Press the Confirm key.

▼ How to change the legend edge

1 Press the Extra key.
2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Stamp’ with the or key.
5 Press the key to enter the ‘Stamp’ menu.
6 Select ‘Legend edge’ with the or key.
7 Press the key to enter the ‘Legend edge’ menu.
8 Select the legend edge with the or key.
9 Press the Confirm key.

▼ How to change the stamp position

1 Press the Extra key.
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2 Select ‘Paper copy’ with the or key.
3 Press the key to enter the ‘Paper copy’ menu.
4 Select ‘Stamp’ with the or key.
5 Press the key to enter the ‘Stamp’ menu.
6 Select ‘Position’ with the or key.
7 Press the key to enter the ‘Position’ menu.
8 Select the position with the or key.
9 Press the Confirm key.
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Menu structure of the scanner
f

Lines/text
Original type Blueprint

Original Photo

Background comp. on
off

Synchrone cut
Standard cut

A0 (841x1189mm)
A1 (594x841mm)
A2 (420x594mm)
A3 (297x420mm)

E (34x44”)
D (22x34”)
C (17x22”)

Cut length B (11x17”)
E+ (36x48”)
D+ (24x36”)

Paper copy C+ (18x24”)
B+ (12x18”)
30”x42”

B1+ (707x1000mm)
B2+ (500x707mm)
B2 (500x700mm)

Mirror On
Off

Rewind original On
Off

Autofeed orig. On
Off

Release orig. On
Off

Scanner
UK English

Language Nederlands
more...

Print menu chart Printing...

Enable On
Off

Stamp

Drawing method Standard
Ericsson

Select Nickname 1
Nickname 2
Nickname 3
Nickname 4
Nickname 5
Nickname 6
Nickname 7
Nickname 8
Nickname 9
Nickname 10

Format Color

Size

Light grey
Grey

Dark grey
Black

Large
Small

Afnor

Legend edge Trailing
Leading

Position Bottom
Middle
Top
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Chapter 4
Using the Océ TDS400 to
Scan-to-file

This chapter describes the scan-to-file function of the Océ
TDS400. This chapter contains a description of the
interface of the Océ TDS400 scanner, and of the Océ Scan
Manager and Océ View Station LT applications on the
local controller
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Introduction

‘Océ Scan Logic®’ is an option which enables you to scan a document and
send it to a specific directory on the network. It makes full use of Océ Image
Logic®, a quality enhancement technology. Enable Océ Scan Logic® through
a password in the Océ Settings Editor. A graphical user interface is supplied
with the ‘Océ Scan Logic®’ option.

You scan in order to:
■ Use the documents again
■ Archive the documents
■ E-mail the documents
■ Prints the documents at a later time

A scan is made at the Océ TDS400 scanner. On the scanner operator panel, you
select the resolution and the destination of the scan.

You can store a generated file on the controller (temporary store) or move the
scan towards a network destination.

With Océ View Station LT you can see the scanned documents later. Océ View
Station LT comes with the Océ Scan Manager application.

Note: The optional Graphical User Interface (GUI) on the controller and a
memory configuration of 256 Mb are required to use Océ Scan Logic®.
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Make a scan

To scan an original to file is an easy operation. If the settings (see ‘Settings to
scan’ on page 77) are correct, you must press the Start key on the scanner
operator panel.

▼ How to make a scan

1 Place your original face-down, right aligned along the original guide.
2 Select the appropriate original type.
3 Press the Output key to select ‘File’.
4 Select a Destination (see ‘Destinations’ on page 86).
5 Press the Start key .

The original is scanned.
Note: Select auto-feed on/off, rewind original on/off, and release paper
on/off in the ‘scanner’ menu on the scanner panel (see ‘Menu structure Océ
TDS400 Scanner’ on page 82). When release paper is enabled, the original
will be fully released after it is scanned.

6 On the controller, Océ View Station LT starts, to show the result of the scan
(see Figure 16).
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[16] Océ View Station
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Settings to scan

Press the Extra key on the scanner operator panel to access the settings to make
a scan. The following options are available in the ‘File’ menu:

Destination You can store your scan either in the temporary storage on the
controller or you can store it on a network destination. You can define a
maximum of six destinations in the Scan Manager application. You can select
one of these destinations on the scanner operator panel.

Checkprint A Checkprint is a print from the scanned original. You can turn the
checkprint on or off.

File resolution The Océ TDS400 Scan Logic® option can scan three
resolutions: 200, 300 or 400 dots per inch (DPI). The higher the resolution, the
better the image quality. Higher resolution also causes larger file size.

File format To define the internal order of the scanned files, select between
TIFF (Tagged Image File Format), CALS-I (Continuous Acquisition and Life
Cycle support), or PDF (Portable Document Format).

Optimize size Select this option to decrease the size of the file or to get good
quality.

Set the scan size In the ‘Original’ menu.
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Destinaspbtion

You can store your scan either in the temporary store on the controller or on a
network destination. You can define up to six destinations in the Océ Scan
Manager application. On the scanner operator panel you can choose one of
these destinations.

▼ Select a destination

1 Press the Extra key.
2 Select ‘Destination’ with he or key.
3 Press the key, to enter the ‘Destination’ menu.
4 Select the needed ‘Destination’ with he or key.
5 Press the Confirm key.

Note: The names of the destinations can be any. However, for your
convenience, you are able to define understandable nicknames in the Océ Scan
Manager application (see ‘Create a local destination’ on page 86).

Checkprint

A Checkprint is a print from the scanned original. You can turn Checkprint on
or off.

▼ Select Checkprint

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘Checkprint’ with he or key.
4 Press the key, to enter the ‘Checkprint’ menu.
5 Select ‘on’ or ‘off’ with the or key.
6 Press the Confirm key.

Resolution

The Océ TDS400 Scan Logic® option can scan three resolutions:
■ 200 dots per inch (dpi)
■ 300 dpi
■ 400 dpi

To reach the best print quality on the Océ TDS400 select 300 dpi.
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▼ Select the resolution

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘File resolution’ with he or key.
4 Press the key, to enter the ‘File resolution’ menu.
5 Select the needed resolution with the or key.
6 Press the Confirm key.
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File format

To define the internal order of the scanned files, select between TIFF (Tagged
Image File Format), CALS-I (Continuous Acquisition and Life Cycle support),
or PDF (Portable Document Format).

Within the ‘Tiff format’ option, you can define 9 different Tiff subformats. The
‘Organization’ and ‘Compression’ of the file are determined by the Tiff
subformat you select.

Organization
■ Stripped
■ Tiled
■ Raw

Note: Select ‘Stripped’ or ‘Tiled’ when you can use these organizations later.
Select ‘Raw’ in another case.

Compression
■ Group 4
■ Group 3-1D
■ None

Note: Select ‘Group 4’ or ‘Group 3-1D’ when you can use these compressions
later. Choose ‘None’ in another case.

Note: ‘Group 4’ or ‘Group 3-1D’ are compression methods which are best for
text and vector drawings. If you select these compressions to scan a photo with
many gray scales these compressions can cause a negative compression: the
file size increases instead of decreases.

▼ Select file format

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘File format’ with the or key.
4 Press the key, to enter the ‘File format’ menu.
5 Select the required format or subformat with the or key.
6 Press the Confirm key.
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Optimisation

You can turn File size optimization’ or ‘off’. If you select ‘on’ the file size is
smaller, the scan quality will be less.

▼ Select optimise size

1 Press the Output key to select ‘file’.
2 Press the Extra key.
3 Select ‘Optimise size’ with he or key.
4 Press the key, to enter the ‘Optimise size’ menu.
5 Select ‘on’ or ‘off’ with the or key.
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Menu structure Océ TDS400 Scanner

 
w=A0 l=synch l= synch 

w=A1 l=synch   A0 

w=A2 l=synch  

w=A3 l=synch  

w=A4 l=synch  

w=34  l=synch   

w=22  l=synch   

Standard size w=17  l=synch   

w=11  l=synch   

w=8.5  l=synch   

Scan size w=36  l=synch    

w=24  l=synch   

w=18  l=synch   

w=12  l=synch   

w=9  l=synch   

w=30  l=synch   

  w=B1 l=synch   

  w=B2 l=synch   

Original  w=B1+ l=synch   

  w=B2+ l=synch   

  

Custom width w=123mm l=synch 
  

Custom size w=123mm l=12.3  
 

Lines/text 
Original type Blueprint  

Photo 
  

Background comp. on 
off 

Destination 1 
Destination 2 
Destination 3 

Destination Destination 4 
 Destination 5 
 Destination 6 
  

Check print on 
 off 

File 200 dpi 
File resolution 300 dpi 

400 dpi 
 

TIFF G3 RAW 
TIFF G3 strip 
TIFF G3 tiled 
TIFF G4 RAW 
TIFF G4 strip 

File format TIFF G4 tiled 
TIFF unc. RAW 
TIFF unc. strip 
TIFF unc. tiled 

CALS 
PDF unc. 
PDF G4 

 
Optimize size on 

off 

Rewind original on 
off 
 

Autofeed orig. on 
off 
 

Scanner Release orig. on 
off 
 

US English 
Language Nederlands 

more... 
 

Print menu chart Printing... 
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Océ Scan Manager

The Océ Scan Manager is an application available local on the controller. With
the Océ Scan Manager you can configure the destinations for Océ Scan
Logic®. To increase your productivity you can define automatic file naming.
This way you can do batch scans without operating the controller.

During scanning, Océ Scan Manager displays the filename and the status of the
file generation process. When the scan is completed a view of the scanned
image is automatically displayed on the controller.

Figure 17 shows an example of the Océ Scan Manager application. The left
part displays a tree view containing folders containing destinations. The right
part displays a table view containing the content of the folder currently
selected.

[17] Overview of the Océ Scan Manager application

Note: Not all options are available to all users. You must log on to a particular
user mode to do specific tasks with Océ Scan Manager (see ‘Océ TDS400
users’ on page 18).
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Tree view

The tree view displays:
■ the system name
■ the collapsible destination tree
■ the collapsible temporary store tree.

If you scan to a particular destination, that destination is displayed bold and the
corresponding icon changes. The destination you scanned last to, is displayed
bold.

If for any reason a scan can not be sent to the correct remote destination, the
file is stored in the ‘Unsent’ folder.

Table view
The table view (on the right side of figure 17 on page 83) displays the file
names of the files in the opened destination or temporary folder.

Each file has the following information:
■ Name
■ Size
■ Type
■ Modified
■ Resolution
■ Image size.

If the currently viewed destination is the one you are scanning to, then the
scanned file appears at the end of the table. If you currently view another
destination than the one you are scanning to, then the scanned to destination is
displayed bold.

It is possible that there are more files in the table than fit on screen. The most
recent scanned file appears at the end of the table. Under these circumstances
it is possible that your most recent scanned file is not visible in the table on
screen. In this case you can update the table view.
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▼ Update the table view

1 From the ‘View’ menu select ‘Refresh’ or click the ‘Refresh’ button on the
toolbar (see Figure 18). If the opened destination is also the one which is
currently scanned to, then the view is automatically updated.

[18] ‘Refresh’ button on the toolbar
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Actions from the Océ Scan Manager

The Océ Scan Manager enables you to make settings for scan-to-file. You can
edit and view the destination properties. You can also view the properties of
scanned files.

Destinations

A destination is a location where you scan your file to. You can create, delete
and lock destinations. You can also define automatic file naming to ensure your
files get the desired names.

A destination can also be a file server or a PC of an end user. It is better to select
remote destinations instead of the local ones. The local destinations are
temporary and can only contain a limited number of scan files. Define the
‘Scan memory reservation’ in the Océ Settings Editor. See the on-line help on
the Océ Settings Editor for more details.

▼ Create a local destination

1 Select ‘Destinations’ in the tree view.
2 Open the ‘File’ menu and select ‘New’ or click on the ‘New’ button on the

toolbar (see Figure 19).

[19] ‘New’ button on the toolbar



Using the Océ TDS400 to Scan-to-file 87

[20] ‘Destination properties’ window

3 Enter a logical name for the destination in the ‘Name’ text box.
This logical name also appears on the scanner panel S.

4 Select the ‘On the controller’ type from the ‘Type’ drop-down list box.
5 Enter a path of the target folder in the ‘Path’ text box. You can also click the

‘Browse’ button to select the path.
Note: This is only possible if you select ‘On the controller’ as ‘Type’ (see
step 4).

6 Click Ok to accept the destination properties.

▼ Create a network destination with SMB

1 Create a shared folder on a workstation. For example c:\Scan
2 On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on

the ‘New’ button on the toolbar (see Figure 19).
The Destination Properties dialog box appears (see Figure 20)

3 Select SMB from the ‘Type’ drop-down list box.
4 Enter the system name of the workstation where you created the shared folder.

Note: Find the system name of the workstation on the control panel of the
workstation (Control panel - Network - Identification - System name)

5 Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT® , Windows® 2000 and XP, use the DOS name of the shared
folder.
For Windows 95/98® use the folder name. This is case sensitive.
Note: You can not Browse. Instead of entering the path name by hand, you
can use the drop-down list box to select a shared folder available on the
selected system.

6 If you have set a username and a password for the shared folder on the
workstation, then enter the username and the password in the required fields.
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7 Set the required file naming properties
8 Click OK

Océ Scan Manager connects to the new SMB destination. Océ Scan Manager
then shows the contents of the new SMB destination.

▼ Create a web destination with FTP

1 Create a home directory and a subdirectory on a workstation. For example
c:Ftp/Scan

2 Enable FTP on the workstation
3 On the Océ Scan Manager Open the ‘File’ menu and select ‘New’ or click on

the ‘New’ button on the toolbar (see Figure 19).
The Destination Properties dialog box appears (see Figure 20)

4 Select FTP from the ‘Type’ drop-down list box.
5 Enter the system name of the workstation where you created the shared folder.

Find the system name of the workstation on the control panel of the
workstation (Control panel - Network - Identification - System name)

6 Enter the path name. This is the name of the shared folder on your workstation.
For Windows NT® , Windows® 2000 and XP, use the DOS name of the shared
folder.
For Windows 95/98® use the folder name. This is case sensitive.
Note: You can not Browse.

7 For access to the directory on the workstation through FTP, a user name and
password is set on the FTP server that runs on the workstation. Enter this user
name and this password in the required fields on the Destination Properties
dialog box of the Océ Scan Manager.

8 Set the required file naming properties
9 Click OK

Océ Scan Manager connects to the new FTP destination. Océ Scan Manager
then shows the contents of the new FTP destination.

Note: You can create a maximum number of 10 destinations.
Note: Names in Japanese can only be entered for remote destinations in
SMB.
A key operator can determine whether a destination can be modified by an
anonymous user. This done by locking and unlocking a destination.

▼ Lock a destination

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’.
3 Check the ‘Locked’ check box.
4 Click ‘OK’ to accept the destination settings.

The destination properties are now locked.
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Note: This option is only available if you are logged on as a Key operator (see
chapter 9, ‘Océ Account Center’ on page 145).

▼ Unlock a destination

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’.
3 Uncheck the ‘Locked’ check box.
4 Click ‘OK’ to accept the destination settings.

The destination properties are now unlocked.
Note: This option is only available if you are logged on as a Key operator (see
‘Océ Account Center’ on page 145).

▼ Delete a destination

1 Select a destination.
2 Open the ‘File’ menu and select ‘Delete’ or click the ‘Delete’ button on the

toolbar (see Figure 21).

[21] ‘Delete’ button on the toolbar

The selected destination is deleted.
Note: This option is only available if you are logged on as a Key operator or
as a Repro operator.

Note: You are not able to delete the last destination.

▼ Define a file name

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’.

The ‘Destination properties’ screen appears (see Figure 20 on page 87).
3 Enter a name in the ‘Base name’ text box.

Note: The ‘Base name’ may contain ‘###’ for automatic file naming. The
‘###’ will be replaced by an ascending number. You may place as many
dots in the ‘Base name’.

4 Select or clear the check box ‘Add correct file extension’ to add or leave out
the file extension. Set the file extension in the Océ Settings Editor.

5 Click ‘Apply’ or press Enter to accept the settings.
When you scan, the scanner operator panel displays the file name.
Before a new scan-to-file job, enter a new file name or replace the file name
with ###. When the file name is not changed, the new scan-to-file job
overwrites the previous scan-to-file job.
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▼ Set or Change destination properties

1 Select a destination.
2 From the ‘File’ menu select ‘Properties’ or click the ‘Properties’ button on the

toolbar (see Figure 22).

[22] ‘Properties’ button on the toolbar

The ‘Destination properties’ screen appears as in figure 20 on page 87.
3 Change the destination properties as described in ‘Create a local destination’

on page 86.

Scanned files

The right pane of the Scan Manager contains the scanned files and additional
information about the files. You can view, print and delete these files. You can
also view the file properties.

▼ View a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘View’ or click the ‘View’ button on the toolbar

(see Figure 23).

[23] ‘View’ button on the toolbar

Océ View Station LT starts and displays the file.
Note: When you make a scan Océ View Station LT starts automatically, and
shows the result of the scan.

▼ Print a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘Print’ or click the ‘Print’ button on the toolbar

(see Figure 24).

[24] ‘Print’ button on the toolbar

The selected file will be printed with the default settings as defined in the Océ
Settings Editor.
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▼ Delete a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘Delete’ or click the ‘Delete’ button on the toolbar

(see Figure 25).

[25] ‘Delete’ button on the toolbar.

The selected file will be deleted.
Note: This option is only available if you are logged on as a Key operator
or as a Repro operator.

▼ View properties of a scanned file

1 Select a file in the right pane.
2 From the ‘File’ menu select ‘Properties’ or click the ‘Properties’ button on the

toolbar (see Figure 26).

[26] ‘Properties’ button on the toolbar.

The following window appears (see ‘‘Scanfile properties’ window’ on
page 91):

[27] ‘Scanfile properties’ window

3 Click ‘OK’ to close the ‘Scanfile properties’ window.
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▼ Automatically view a file after scanning

You can choose to view a file automatically after scanning:
1 From the ‘System’ menu select ‘Auto view’.

When you scan, Océ View Station LT starts automatically and show the
scanned file.

Manage the temporary store

When you normally scan the originals to a file, many files are created in the
temporary store. You can clean the temporary store:
■ manual: from the ‘System’ menu select the ‘Purge’ command.
■ automatic: you must make some settings in the Océ TDS400 Settings Editor.
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How to retrieve scanned files

When you scan your files will be stored in the destination you set. This can be
on the local controller or on a remote system. You can retrieve your files from
the local host via File Transfer Protocol (FTP) (see Figure 28). Also if during
scanning to a remote destination, something goes wrong, you can retrieve your
files from the local host.

[28] How to retrieve scan files

Get files via FTP

1 Launch an FTP client.
2 Enter the ‘ftp’ command.

A DOS box now appears with the FTP prompt.
3 Enter the ‘Open’ command followed by either the registered name of the Océ

Power Logic® Controller or the IP address (for example: 194.2.66.146) to
connect to the Controller and press Enter: ‘open 194.2.66.146’.
Note: Instead of performing steps 2 and 3 you could also enter “ftp
host_name” in the FTP client.
The connection with the Controller is now established and a window appears
asking you for a user name.

4 Enter your user name ‘anonymous’, and enter as your password also
‘anonymous’.
A connection is now set up for the default user ‘anonymous’.

Remote client

Remote client

Power Logic Controller
Windows XP®

Get files via FTP

Get files via FTP
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Note: As there is no registered user, you can press Enter to initiate the
connection.

5 Set the transmission mode to binary by entering ‘binary’.
6 Go to the ‘tempstore’ directory using the following command: ‘cd tempstore\’.
7 Go to the ‘scan’ directory if you want to retrieve a file from a destination on

the local host,
or
go to the ‘unsent’ directory if you want to retrieve a file from ‘unsent’ folder
on the local host.

8 Get the data file (for example: bugatti.tif) via the ‘get’ command:
‘get bugatti.tif’.

9 Quit FTP by entering the ‘bye’ command.

Note: You can retrieve multiple files by the ‘mget *’ command or the ‘mget .‘
command. Which command you can use is release dependent.
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Océ View Station LT

With Océ View Station LT you can view your scanned files. This can be
automatically (see ‘Automatically view a file after scanning’ on page 92) after
scanning or via Scan Manager (see ‘Print a scanned file’ on page 90).

Océ View Station LT has the following menu’s (see Figure 29):
■ File
■ View
■ Preference
■ Help

[29] Océ View Station
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Menu options

File menu
Command What does it do
Close Closes the active document
Properties Provides technical information about, and allows you to change cer-

tain properties of the document.

[30]

View menu
Command What does it do
Fit Scales the image to fill the window.
1:1 Displays the image at a 1:1 scale factor.
Magnify Zooms into the page.
Reduce Zooms out of the page.
Refresh Redraws all windows displaying the active document.
Invert Reverses the black and white parts of the image.
Mirror Mirrors the image.
Rotate 90 CCW Rotates the image 90 degrees counter-clockwise.
Rotate 90 CW Rotates the image 90 degrees clockwise.
Rotate 180 Rotates the image 180 degrees.
Sample When active, displays only a sample of bilevel raster pixels.
Negate Reverses the raster image pixels on display and changes which are

dominant for scaling.
Scale to gray When active, displays the active bilevel raster image as though it

were a greyscale image.
Monochrome An image or screen having only background and foreground colors.

Same as black-and-white or bilevel.

[31]

Preference menu
Command What does it do
View ribbon View Ribbon displays and removes the ribbon that contains but-

tons. The View Ribbon appears, by default, below the menu bar. It
serves as a fast means of selecting some File, View, and Preference
menu commands.

Status bar Status Bar displays and removes the Status Bar at the bottom of the
Océ View Station LT window. The Status Bar displays the pointer
co-ordinates and a status line.

[32]
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Note: You can retrieve help about Océ View Station LT via the Océ Scan
Manager.

Function buttons

Below the menu’s there are function buttons in a ribbon. This ribbon can be
turned on and off (see ‘View ribbon’ on page 96).

[34] Function buttons in Océ View Station

The above figure displays the buttons:
1 Invert: Reverses the black and white parts of the image.
2 Fit: Scales the image to fill the window.
3 1:1: Displays the image at a 1:1 scale factor.
4 Magnify: Zooms into the page.
5 Reduce: Zooms out of the page.
6 Mirror: Mirrors the image.
7 Rotate 90 CCW: Rotates the image 90 degrees counter-clockwise.
8 Rotate 90 CW: Rotates the image 90 degrees clockwise.
9 Rotate 180: Rotates the image 180 degrees.

10 Measurement When active, allows you to measure lines and areas on the
image.

Reference Reference displays or removes a small, usually floating window.
This window displays the entire current page in miniature. The
crossed box inside the Reference window indicates which part of
the page is displayed in the document window.
By moving or resizing the crossed box, you change which area of
the page is displayed.

Detail Displays or removes the Detail window.
Measurement When active, allows you to measure lines and areas on the image.

Help menu
Command What does it do
About Shows information about Océ View Station.

[33]

Preference menu (continued)
Command What does it do

[32]

2 3 4 5 6 8 9 10 11 121 7
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11 Reference. This small floating window displays the entire current page in
miniature for reference.

12 Displays or removes the Detail window.

View error

When the memory is almost full it can occur that the viewer does not show the
scanned file. Instead it shows a red border with a red cross (see Figure 35).

[35] Error view in Océ View Station
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Chapter 5
Océ Power Logic®: The Settings
Editor

This chapter gives information about the Océ Settings
Editor. For details about specific settings, refer to the Help
on the Océ Settings Editor.
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Introduction

Use the Océ Settings Editor to set the default settings of the Océ TDS400
according to your companies requirements. 2 types of users can determine
settings in the Océ Settings Editor, Key Operators and System Administrators.
You can log on as either Key Operator or System Administrator. Key Operators
and System Administrators have different rights to determine settings.
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How to start up and shut down the
controller

Take the following actions to start up the controller:

▼ Start up the Océ controller

1 Turn on the controller and the screen.
After the initial system test of the controller the applications, Océ Queue
Manager, Océ System Control Panel, Océ Settings Editor and Océ Scan
Manager are automatically started and the Océ TDS400 is ready for operation.
Note: The Océ Queue Manager and the Océ System Control Panel applications
are visible on the screen; however the Océ Settings Editor is minimised, to save
screen estate.

Take the following actions to shut down the controller:

▼ Shut down the Océ controller

1 Go to the Océ System Control Panel application.
2 Select the ‘Shutdown’ option from the ‘System’ menu.
3 Confirm shutdown by clicking on the ‘Yes’ button in the ‘Shut down’ window.

The system automatically performs the shutdown procedure for the controller.
Finally, the Windows XP ‘Shutdown Computer’ window appears, which
informs you that you can turn off your computer.
Note: You can now restart the controller by pressing the ‘Restart’ button.

4 Turn off your computer and display.

Note: The Océ TDS400 has a sleep mode. The sleep mode powers off almost
all the power supplies after a certain time of inactivity.
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Océ Settings Editor

The Océ Settings Editor is one of the controller applications for the Océ
TDS400. The Océ Settings Editor allows users and operators to view settings
of the system. If authorised, the settings of the system can be modified on the
Océ Settings Editor.

With the Océ Settings Editor two groups of settings can be configured:
■ Key Operator settings (KO settings)

The Key Operator group allows authorised users to configure default settings
for copy and print jobs, default off-line fold settings and scan-to-file options.
With the Key Operator settings also the printer, system and scanner defaults
can be set or modified. A subset of the Key Operator settings are the Repro
Operator settings. The Repro Operator has no rights to change settings in the
Océ Settings Editor. In the Océ Queue Manager and the Océ System Control
Panel the repro operator has the same user rights as the Key Operator and
System Administrator. See ‘User modes’ on page 137.

■ System Administrator settings (SA settings)
The System Administrator group allows authorised users to configure default
printer language (PDL) settings and printer pen settings. It also allows the
System Administrator to configure system and connectivity settings.

These groups of settings can be selected from the ‘View’ menu of the Océ
Settings Editor.

Setting dependencies The Océ Settings Editor is used to display and edit a
specified group of settings. Some settings are related to other settings,
however. If you want to change settings which have dependencies with other
settings you will be prompted with a message. When a setting is changed, the
system automatically updates the related settings.

Also, when you change certain settings, such as measurement unit or paper
series, all related settings are instantaneously converted to the new setting
(with a bullet for the settings that are changed).
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[36] Océ Settings Editor

General structure
The Océ Settings Editor is structured as follows:
■ Menu bar
■ Top toolbar
■ Left toolbar
■ Settings area
■ Status bar
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Menu bar

The menu bar of the Océ Settings Editor contains the following menus:

File If you select the ‘File’ menu you can log on as a particular type of user,
log off from the previously selected user mode, open an existing setting file,
save the current settings to a file, connect to a different controller (only for
remote users) or exit the Océ Settings Editor.

Edit If you select ‘Options’ from the ‘Edit’ menu, a window is displayed in
which you can view your default system and the display languages (first and
second) for the Océ Settings Editor application. The ‘Automatic logon’ option
allows you to start the Océ Settings Editor application automatically in the
specified user mode.

View The ‘View’ menu allows you to switch between the display languages as
defined in the Edit options window and to switch between KO settings and SA
settings.

Help The ‘Help’ menu contains the following options: ‘Contents of Océ
Settings Editor’ and ‘About Océ Settings Editor’.

[37] Menu bar

Top toolbar

The top toolbar of the Océ Settings Editor contains four control buttons:
‘Open’, ‘Save as’, ‘Apply’ and ‘Undo’.

[38] Top toolbar

Open When you click on the ‘Open’ button, you open a saved file.

Save as All Key Operator and System Administrator settings can be saved in
a file. This way you can have different settings for different customers,
departments or other situations.
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Note: These settings can only be saved in Key Operator or System
Administrator mode.

Apply When you click on the ‘Apply’ button, the changes you have made
become effective. Initially, this button is disabled. It is enabled after the first
setting is changed and disabled again after the apply action is performed or
after an undo action.

Undo This button restores the settings to the state it was in the last time the
settings were applied (and not back to the factory default). Initially, the ‘Undo’
button is disabled. This button is enabled the moment the first setting is
changed. It is disabled after an Apply action is performed or after an undo
action

▼ Save settings to file

1 Open the ‘File’ menu and select ‘Save as’, or press the ‘Save as’ button on the
toolbar.
You now have two possibilities:
■ If the client is a local client, a dialog is displayed and the user can supply a

file name. The file is saved in a predefined directory on the system.
■ If the client is a remote client, a dialog box is displayed and the user can

supply a directory and a file name.
Note: All settings in the current view mode are saved; not only the ones that
are currently visible.

A few special files are available here:
■ Default.kos/Default.sas

These files contain the factory default settings for the Key Operator and
System Administrator, respectively, and can not be changed.

■ Backup.kos/Backup.sas
These files contain a previous version of the settings for the Key Operator
and System Administrator, respectively (before the last Apply).

■ Current.kos/Current.sas
These files contain the version of the settings for the Key Operator and
System Administrator after the last Apply.

When an Apply is performed, first the contents of the current settings is copied
to the backup file. There are two versions of this file, one for KO settings and
one for SA settings. These files are always stored on the system.
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▼ Open a saved file

1 Open the ‘File’ menu and select ‘Open’, or press the ‘Open’ button on the
toolbar.
A dialog box is displayed from where you can choose the correct file.

2 Click the ‘Apply’ button.
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged on as a Key Operator or System
Administrator.

Left toolbar

There are four different buttons available at the left toolbar of the Océ Settings
Editor. These are ‘Jobs’, ‘Printer’, ‘Scanner’ and ‘System’. Each button
provides access to a specific group of settings. By clicking on each of these
buttons, you can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

[39] Left toolbar

Settings area

The settings area consists of two parts: a setting tree and an update area.

Tree structure Most settings are displayed using a tree structure. By clicking
on the settings, folders can be opened to show all the entries or closed to hide
all the entries below these folders.
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The settings for system components that are not available are not displayed.
So, if you do not have a folder, no folder settings are available. This means that
different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a
bullet.

Update area The user can move through the tree and select a setting. If he
selects a setting for which he is authorised, he can edit the setting in the update
area.

If the user is not authorised for a particular setting, the update area is grayed
and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from
the tree structured, but are accessed directly from the settings area.

The update area contains some additional information about the selected
setting. This includes a brief definition of the setting, as well as the minimum,
maximum and default values (if appropriate).

[40] Settings area
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Status bar

The Océ Settings Editor has a status bar displaying the following information
(left to right):

■ System status (icon for connected or disconnected)
The following icons are used:

The Océ Settings Editor is connected to a system.

The Océ Settings Editor is not connected to a system.

■ System name (‘localhost’ if you are working at the controller)
■ User mode (Repro operator, Key Operator, System Administrator or

anonymous)
■ View mode (KO settings or SA settings).

How to access the Océ Settings Editor

In order to perform special Key Operator functions, you must log on to the Océ
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is
required to access them. The service engineer will provide this password to
you upon installation.

Note: Only one Key Operator or System Administrator at a time is authorised
to make modifications. However, there may be multiple users viewing the
settings. When a second user tries to log on as Key Operator or as System
Administrator, an error message is displayed.

Start Océ Settings Editor

You can start the Océ TDS applications on the controller as well as on a remote
workstation.

▼ Start Océ Settings Editor on the Océ Power Logic® Controller

1 Select the 'Launcher' application.
2 Select Océ Settings Editor. Océ Settings Editor starts.
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▼ Start Océ Settings Editor on a remote workstation

Note: You must first install Océ Remote Logic® as described (see
‘Installation procedure for MS Windows® systems’ on page 131).

1 Select 'Océ Remote Logic®' via the 'Start' menu.
2 Select the 'Launcher' application.
3 Select Océ Settings Editor. Océ Settings Editor starts.

How to perform actions from the Océ Settings Editor

You can perform a number of activities from the Océ Settings Editor. These
activities include:

■ Save settings to file
■ Load settings from a file
Save and load settings All Key Operator and System Administrator settings
can be saved in a file or loaded from a file. This way you can have different
settings for different customers, departments or other situations.

Note: These settings can only be saved in Key Operator or System
Administrator mode.

▼ Save settings to file

1 Open the ‘File’ menu and select ‘Save as’.
You now have two possibilities:
■ If the client is a local client, a dialog is displayed and the user can supply a

file name. The file is saved in a predefined directory on the system.
■ If the client is a remote client, a dialog box is displayed and the user can

supply a directory and a file name.
Note: All settings in the current view mode are saved; not only the ones that
are currently visible.

A few special files are available here:
■ Default.kos/Default.sas

These files contain the factory default settings for the Key Operator and
System Administrator, respectively, and can not be changed.

■ Backup.kos/Backup.sas
These files contain a previous version of the settings for the Key Operator
and System Administrator, respectively (before the last Apply).

■ Current.kos/Current.sas
These files contain the version of the settings for the Key Operator and
System Administrator after the last Apply.
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When an Apply is performed, first the contents of the current settings is copied
to the backup file. There are two versions of this file, one for KO settings and
one for SA settings. These files are always stored on the system.

▼ Load a settings file

1 Open the ‘File’ menu and select ‘Open’.
A dialog box is displayed from where you can choose the right file.

2 Click the ‘Apply’ button.
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged in as a Key Operator or System
Administrator.
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Key Operator settings

The Key Operator is responsible for correct default settings of the system.
These settings include the default settings, and groups of default printer
settings for the print and the copy jobs that again occur.

The Key Operator can define all timer settings, like the panel time out and the
sleep mode time out.

Note: One Key Operator or System Administrator can log on to the Océ
Settings Editor at the same time.

In order to perform special Key Operator functions, you must log on to the Océ
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is
required to access them. The service engineer will provide this password to
you upon installation.

Note: When you are finished, make certain you log off from the Key Operator
mode of the Océ Settings Editor to prevent unauthorized use of the Océ
TDS400.

▼ Make Key Operator settings in the Océ Settings Editor

1 maximise the Océ Settings Editor on the screen.
2 Log on as Key Operator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings are made directly from the tree structure area.
6 Click on the ‘Apply’ button.

The new value is now applied for the setting
Log from the Key Operator mode when you have finished updating the
settings.
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System Administrator settings

The Océ TDS400 System Administrator is responsible for:

■ Dithering matrix and Poker settings
■ Printer language controller settings
■ Pen settings
■ Automatic Language Selection (ALS) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings.

Note: Poker stands for Portable Kernel. Poker performs automatic
interpretation of the host language in which the data from the scanner or in the
job ticket is encoded. Poker makes sure that the quality between the input from
the printer driver or scanner and the output from the printer is consistent.
Poker supports data compression for scan-to-file and changes raw data from
the scanner into high level file formats.

To modify the System Administrator settings you have to access the SA
settings in the Océ Settings Editor.

There are two types of System Administrator settings (see Figure 41):

■ Printer
■ System

.

[41] System Administrator settings in the Océ Settings Editor
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In order to perform special System Administrator functions, you must log on
to the Océ Settings Editor as a System Administrator (see ‘User modes’ on
page 137).

Note: When you are finished, make certain you log off from the System
Administrator mode of the Océ Settings Editor to prevent unauthorized use of
the Océ TDS400.

▼ Make System Administrator settings in the Océ Settings Editor

1 Maximise the Océ Settings Editor on the screen.
2 Log on as System Administrator.

See ‘User modes’ on page 137 for more information about logging on to the
Océ Settings Editor.

3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the default pen settings, are made directly
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 Log off from the System Administrator mode when you are finished updating
settings.
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Chapter 6
Océ Power Logic®: System
Control Panel

This chapter describes how to view the status of the Océ
TDS400.
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Introduction

The Océ System Control Panel (SCP) application provides you with status
information about the system. This includes:
■ Status of the printer
■ Overview of the loaded media types and sizes
■ Status of the scanner
■ Status of the controller
■ Memory usage.

Note: If you do not have a scanner, the scanner status is not available. If you
have a scanner only, the machine status of the printer and the overview of the
loaded media is not available.

Structure

The Océ System Control Panel window is divided into the following parts (see
Figure 42 on page 118):

The menu bar which contains the following menu’s:
■ File - Logon, Logoff, Connect to and Exit.
■ Edit

If you select this option a window is displayed in which you can view your
default system for the Océ System Control Panel application. The
‘Automatic logon’ option allows you to start the application automatically in
the indicated user mode.

■ View
The View menu allows you to switch between the display languages as
defined in the Edit options window and to enable or disable Océ System
Control Panel sub windows.

■ System
The System menu allows you to dump your configuration settings, make a
demo print, clear the system and shut down the system.

■ Help options: Contents of Océ System Control Panel, About Océ System
Control Panel.

■ Toolbar
The toolbar of the Océ System Control Panel contains the following keys:
Printer: to hide or to show the status of the printer.
Media: to hide or to show media information.
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Scanner: to hide or to show the status of the scanner.
Controller: to hide or to show the status of the controller.
Memory: to hide or to show the amount of set memory that is used.

Note: If operator invention is required for a device, the respective key flashes.

The Printer status window Displays the current status of the Printer. Any error
messages displayed on the printer control panel also appear in the printer status
window of the Océ System Control Panel.

The Media display Provides graphical information about the status of the rolls
and sheetfeeders (available, empty or disabled) of the printer and about the
available media (size and type).

Note: If the Media type equals polyester, the thickness is expressed in mil
(0.001"), otherwise the weight is expressed in g/m2.

When a roll or tray is disabled the roll icon is dimmed and the media
information is replaced by the text “-disabled-” (see ‘Icons’ on page 118).

Note: Special media are excluded from the automatic behavior of the Océ
Power Logic® Controller.

The Scanner status display Displays the current status of the scanner. Any
error messages displayed on the scanner control panel will also appear in the
scanner status window of the Océ System Control Panel.

The set memory meter Indicates how much of the set memory is filled. The
information is displayed in the form of a meter which is divided into three
zones:
■ Green: safe, you have enough space left to print large jobs/many small jobs
■ Orange: pay attention, you might reach the set memory limit soon
■ Red: the set memory is (nearly) full; you should remove files or wait until

files are printed and automatically removed or flushed from memory. No
more print jobs are accepted. Copy jobs can still be made.

Note: At the right of the set memory meter a percentage is displayed,
indicating the amount of set memory currently being used.
Below the Océ System Control Panel main window is displayed:



118 Océ TDS400 User Manual

[42] Océ System Control Panel window

Note: You can hide the media by de-selecting it in the View menu option.

Icons

The Océ TDS400 System Control Panel uses a number of icons to display
information about the media available on the printer. The following icons are
used:

The material is available and the roll is ready for printing.

The roll is disabled.

The roll is enabled but empty.
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User operations

The Océ System Control Panel allows you to perform the following operations:
■ Make a demo print
■ Print your system configuration
■ Clear the system
■ Shut down the system

▼ Make a demo print

1 Select the Demo print option in the System menu.
A demo print is made on the printer.

▼ Print your system configuration

1 Select the Print settings option in the System menu.
A list is printed of the current settings on the Océ Power Logic® Controller.

▼ Clear the system

1 Select the Clear system option in the System menu to delete all jobs.
You can use this option in case of a corrupt job which can not be deleted with
the help of the Océ Queue Manager.
Note: This option is only available in repro operator, key operator and
system administrator mode. In anonymous user mode it is not possible to
clear the system.

▼ Clear the system on printer panel

1 Press the ‘on-line’ key to put the printer off-line.
2 Select the ‘System’ item with the or key.
3 Press ‘next/select’ to enter the ‘System’ menu.
4 Select ‘Clear setmem’ with the or key.
5 Enter password
6 Press ‘next/select’ to enter the ‘Clear setmem’ menu.
7 Select the ‘on’ or ‘off’ with the or key.
8 Press ‘on-line’ to put the printer on-line again.

▼ Shut down the system

1 Select the Shut down option in the System menu to shut down the system.
Note: This option is only available in repro operator, key operator and
system administrator mode. In anonymous user mode it is not possible to
shut down the system.



120 Océ TDS400 User Manual



121

Océ TDS400

User Manual

Chapter 7
Océ Power Logic®: Queue
Manager

This chapter describes how to view and manage jobs in the
Océ TDS400 print queue, inbox queue, and history queue.
It shows how to cancel the active print and how to delete
the prints, how to hold the print jobs in the queue, how to
restart the jobs, and how to move jobs to top.
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Introduction

The Océ Queue Manager application provides you with a graphical
representation of the print queue. It allows you to view the print queue and the
status of the print jobs as well as to manage the jobs in the queue. With the Océ
Queue Manager you can:
■ Abort the job currently being printed
■ Delete job(s) in the queue
■ Put job(s) in the queue on hold
■ Print jobs from the history queue
■ Print jobs from the inbox queue
■ Move job(s) to the top of the queue
■ Restart job(s) that were previously put on hold in the queue

▼ Start Océ Queue Manager on a remote workstation

Note: You must first install Océ Remote Logic® in ‘Installation procedure
for MS Windows® systems’ on page 131.

1 Select 'Océ Remote Logic®' via the 'Start' menu, or
2 Select the 'Launcher' application.
3 Select Océ Queue Manager. Océ Queue Manager starts.

Note: To start more than one Océ Queue Manager, Océ System Control
Panel or Océ Settings editor you can better use the Application Launcher.

Structure
The Océ Queue Manager window is divided into the following parts (see
Figure 43 on page 124):

The standard menu bar. The menu bar for the Océ Queue Manager contains
the following menus:

■ File: Logon, Logoff, Connect to, Close
■ Edit: set the default printer and 'Automatic logon'.
■ View: selecting the language, switching between queues, and configuring the

view of the queues.
■ Help: About Océ Queue Manager, Contents of the help.
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The tool bar The toolbar for the Océ Queue Manager contains the following
icons: hold, resume, move to top, delete and print job(s).

The active print job window. This window displays the job currently being
printed on the Océ TDS400.

The print queue window. This window has a tabular format and shows the jobs
waiting to be printed. The jobs are displayed in the order in which they are
expected to be printed.

Note: Copy jobs can move in the queue, to take preference over print jobs. This
depends on a setting in the Océ Settings Editor.

Inbox queue The inbox queue contains print jobs which have been sent to the
'Inbox' on the controller. You can print these jobs, view the properties and
delete these jobs.

History queue The history queue contains print and copy jobs which have
been printed. You can print these jobs, view, edit some the properties and delete
these jobs. You can set how long and how many jobs are kept in the history
queue in the Océ Settings Editor.

Note: You can not view the history queue and inbox queue at the same time.
Select either the history queue or the inbox queue from view menu on the
toolbar. They will be visible in the right pane of the Océ Queue Manager
window.

Status bar The Océ Queue Manager has a status bar displaying the following
information:

■ System status (connected, not connected)
■ The connected system
■ The job status e.g. ‘printing job.A0.hp’
■ User mode

For each job the following information is displayed:
■ The current status and schedule of the job in the form of an icon. See ‘Icons’

on page 126.
■ The name of the print job.
■ The type of job (print job / copy job)
■ The name of the user who has submitted the print job.
■ The number of sets and pages.
■ Any remarks (e.g. 'Manual Feed').
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You can resize the columns in the main queue window by dragging the table
header separators. It is also possible to change the order of the columns by
dragging a specific column to a new position.

Note: You can sort the inbox and history. You can not sort the printer queue.

[43] Océ Queue Manager window

Modes

The Océ TDS400 Queue Manager has the following modes:
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode
■ Service operator mode

These different modes are designed to limit access to the specific functions to
authorized users only.

The anonymous user mode only offers view access to the queue. In this mode
the buttons and menu items are disabled.

The repro operator, the key operator and the system administrator modes allow
you to perform a number of activities on the jobs in the queue, with the help of

menu bar

active print job
window

header
separator

print queue

status bar inbox queue

tool bar
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the Abort, Delete, Resume and Hold buttons. The service operator mode is
meant for Océ technicians.

Note: In the Océ Queue Manager and the Océ System Control Panel, the repro
operator, the key operator and the system administrator have the same user
rights. In the Océ Settings Editor, however, the user modes offer different
rights.

Access The access to the key operator, repro operator, system administrator
modes and service operator is password protected to allow only authorized
personnel to use particular functions. You can enter these modes by selecting
the Logon option from the File menu and by specifying the correct password
when prompted for it, (see ‘Log on’ on page 138).

From the ‘File’ menu, select ‘Close’ to exit the Océ Queue Manager.

Job priority The priority of print and copy jobs in the Océ Queue Manager is
determined by the order in which they are submitted to the Océ TDS400.
However, there is a setting in the Océ Settings Editor which allows you to give
copy jobs priority over print jobs.
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Icons

The Océ TDS400 Queue Manager uses a number of icons to display
information about a job in the queue. The following icons are used:

[44] Receiving/received the job

[45] Processing / processed the job

[46] Printing the job

[47] Delivering the job

[48] The delivered job

[49] The deleted job

[50] A job that requires manual feed

[51] The job is placed on hold by the user or the system.

[52] Attention, needs operator attention (e.g. a media request).
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Managing print jobs

▼ View the print queue

The Océ Queue Manager displays all jobs sent to the print queue in a list sorted
according to the order in which they will be printed.

This ordering can be changed by:
■ deleting jobs
■ putting jobs on hold
■ restarting jobs currently on hold
■ moving jobs to top
This list will be automatically updated.

Note: Queue operations can only be performed when you are properly
authorized. Before you can use the Océ Queue Manager in a different
mode, you first have to enter a password to get the required access. See
‘User modes’ on page 137.

▼ Delete print jobs

1 Select the desired job(s) by clicking on them.
Note: You can select a consecutive list of jobs to be deleted by clicking on
the first job, holding down the Shift key and clicking on the last job. You can
select a non-consecutive list of jobs to be deleted by clicking on each
desired job while holding down the Ctrl key.
Note: To delete a job from a remote client, you need repro operator, key
operator or system administrator rights.

2 Click on the Delete button.
A cross icon is displayed in front of the job indicating it will be deleted. After
the job is actually deleted, the job is removed from the queue.
Note: Consider carefully before you use the Delete button. A delete
operation cannot be undone.

▼ Put print jobs on hold

1 Select the desired job(s) by clicking on them.
Note: You can select a consecutive list of jobs to be put on hold by clicking
on the first job, holding down the Shift key and clicking on the last job. You
can select a non-consecutive list of jobs to be put on hold by clicking on
each desired job while holding down the Ctrl key.

2 Click on the Hold button.
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Note: A job that is put on hold will retain its position in the print queue.
Once it reaches the top of the queue, the job that is put on hold will stay
there until it is restarted or deleted. While a job is on hold, other jobs will
be printed, even when they were behind the job on hold in the queue. The
active job and the jobs in printing state can not be put on hold by the Océ
Queue Manager.

▼ Restart jobs that are put on hold

1 Select the desired job(s) by clicking on them.
Note: You can select a consecutive list of jobs to be restarted by clicking on
the first job, holding down the Shift key and clicking on the last job. You can
select a non-consecutive list of jobs to be restarted by clicking on each
desired job while holding down the Ctrl key.

2 Click on the Resume button.
The selected job(s) will now be restarted.

▼ Move jobs to top

1 Select the desired job(s) by clicking on it/them.
2 Click on the ‘Move to top’ button on the toolbar.

If more than one job is selected then the first selected job will be on top, the
second will be on top, the second below that one and so on.

▼ Reprint jobs from the History queue.

1 Select the desired job(s) by clicking on it/them.
2 Click on the ‘Print’ button on the toolbar.

▼ Change number of sets in the history queue

1 Select the desired job(s) by clicking on it/them.
2 Click on the ‘Properties’ button on the toolbar.
3 Select number of sets in the menu window
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Chapter 8
Océ Power Logic®: Remote Logic

This chapter describes how to install and use Océ Remote
Logic®.
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Introduction

Océ Remote Logic® enables you to:
■ View system status (Océ System Control Panel).
■ Manage print jobs (Océ Queue Manager).
■ Change settings (Océ Settings Editor).

For more information see ‘Use Océ Remote Logic®’ on page 136
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Installation procedure for MS Windows®
systems

Before you install Océ Remote Logic®, you must take note of the following
minimum system requirements for the remote system. The system must be a
Pentium® 233 with 32 Mb RAM running Windows® 95, 98, NT® (service pack
3) Windows® 2000 or Windows® XP, Contact your local Océ organisation for
more possible systems.

Océ Remote Logic® (Queue Manager, System Control Panel and Settings
Editor) are on the Océ TDS400 CD-ROM and on the Océ Power Logic®
Controller CD-ROM provided with the system. The installation procedure for
Remote Logic® is quite simple and self-explanatory. When you select the
‘Install remote applications’ option on the CD-ROM, a Wizard starts to guide
you through the installation process. When the installation process is complete
you do not have to restart your system.

Note: Océ Remote Logic® only works when TCP/IP is enabled on your system.
Refer to your system administrator for assistance with the installation
procedure for TCP/IP.

▼ Install Océ Remote Logic®

1 Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® Controller
CD-ROM into the CD-ROM drive of your PC.

2 Select the ‘Install remote applications’ option.
The installation Wizard starts, and asks to select a setup language.

[53] Choosing a setup language
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3 Indicate the required language and click ‘OK’.
4 Follow the instructions on screen to complete the installation of ‘Océ Remote

Logic’.

When the installation is complete, you can start the applications by selecting
them from the specified folder in the ‘Start’ menu.

To work with the applications you first have to connect to an available Océ
TDS400 machine. How to connect is described in ‘How to use the remote
system’ on page 143.

If you plan to work with more than one of the available remote applications,
you are advised to use the “Applications Launcher”, because this uses less
system resources than the individual applications.
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Installation procedure for Unix systems

Océ Remote Logic® is set up to be platform independent. It runs on a variety
of operating systems providing that a Java™ runtime environment is available
for that platform. The Java™ runtime environment must be installed by a user
with system administrator privileges, depending on Java™ Virtual Machine
(VM). It is also assumed that Océ Remote Logic® is installed by an
experienced user.

▼ Install Océ Remote Logic®’

1 Check if a Java™ runtime environment (JRE) is installed on the system. The
preferred version is JRE 1.1.8. Below you can find some links to JRE's for
various UNIX platforms.

2 Unpack the contents of the file ‘RemoteLogic_vX.tar’, from the directory
Products/remotelogic/UNIX, to a subdirectory on the system.

3 Use ‘tar xvf RemoteLogic_vX.tar’ to unpack.
4 Set the environment variable ‘RL_VM_HOME’ to point to the installation of

the JVM.
5 Run the file ‘remotelogic’ with the applications as parameters. (e.g.

remotelogic QM SCP SE to start the three applications), or use ‘remotelogic
AL’, for the application launcher.

Note: If you do not supply any options, a short help text is displayed.

UNIX versions and the required JRE
UNIX version OS version JRE Default installation directory
IBM AIX 4.1.5 1.1.6 /usr/jdk_base
IBM AIX 4.2.1 1.1.8 /usr/jdk_base
IBM AIX 4.3.3 + fix 1.2.2 /usr/jdk_dev2
IBM AIX 4.3.3.10 + fix 1.3.0 /usr/jdk_java130
SUN Solaris 2.6 1.1.6
HP-UX 10.20 / 11 / 1.1.8 1.1.3
LINUX 1.0 1.1.3
LINUX 1.2 1.1.8
Note: OS = Operating System, JRE = Java™ Runtime Environment

[54]
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IBM AIX

For the various versions of IBM AIX, Java™ runtime engines can be
downloaded from:
http://www.ibm.com/java

The preferred version of the Java™ runtime engine for use with Océ Remote
Logic® is the 1.1.8 version.

HP-UX

For HP-UX 10.20 and 11.00 the runtime engine can be downloaded from:
http://www.unix.hp.com/java
The preferred version of the Java™ runtime environment for HP-UX 10.20 and
HP-UX 11.00 is version C.01.18.xx.

Linux

IBM has a runtime engine available for Linux which can be downloaded from:
http://www.ibm.com/java
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Installation procedure for Other systems

In general, Océ Remote Logic® can run on any system with a Java™ VM.

▼ Steps to install Océ Remote Logic® in general

1 Install Java™ Virtual machine (preferred 1.1.8 (or higher)).
2 Extract ‘RemoteLogic_vX.tar’ or ‘RemoteLogic_vX.zip’, from the Océ

Remote logic® CD-ROM.
3 Set the environment variable RL_VM_HOME to point to the Java™ VM

installation directory.
4 If needed, edit the remote logic script or batch file.
5 Use remotelogic script or batch file to start the applications.
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Use Océ Remote Logic®

Océ Remote Logic® enables you to:
■ View the system status (Océ System Control Panel).
■ Manage print jobs (Océ Queue Manager).
■ Change settings (Océ Settings Editor).

Océ Remote Logic® has five different user modes. These user modes are
meant to limit access to the special functions to authorised users only. Log on
to get access to one of the user modes.

Change the display language, to operate Océ Remote Logic® in the language
of your selection. refer to the on-line help for information on how to do this.

The Océ Remote Logic® applications can operate separately. If you start the
applications separately, you have to log on and select a language in each
application. If you start the applications via the ‘Application Launcher’, the
language is selected automatically.

Note: The default language is English US.

Start the Océ TDS applications via the ‘Start’ menu or via the ‘Application
Launcher’ application.

▼ Start Océ Remote Logic® on a remote workstation

1 Select 'Océ Remote Logic' via the 'Start' menu.
2 Select ' Application Launcher'.
3 Select the required application from the ‘Application Launcher’.
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User modes

The following user modes are available:
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode
■ Service operator mode

The anonymous user mode only offers monitoring capabilities. You are not
allowed to change anything.

The repro operator, the key operator and the system administrator modes allow
you to perform a number of user actions.

In the Queue Manager and the System Control Panel the repro operator, the key
operator and the system administrator have the same user rights. The repro
operator, the key operator and the system administrator modes allow you to
perform a number of activities on the jobs in the queue, with the help of the
Abort, Delete, Resume and Hold buttons.

In the Settings Editor, however, the user modes offer different rights. In repro
operator mode, the operator is allowed to only view settings in the key operator
and system administrator views.

In key operator mode, the operator is allowed to view and change settings in
the key operator view. The key operator is also allowed to view system
administration settings, but is not able to change them.

In system administrator mode, the operator is allowed to view and change
settings in the system administrator view. The system administrator is also
allowed to view key operator settings, but is not able to change them.

The service operator mode is meant for the Océ technician.

When you are not authorised to perform a certain action, the action is grayed
out.

Note: The status bar at the bottom displays the active user mode.
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Log on

The access to the key operator, repro operator, system administrator and
service operator modes is password protected to allow only authorised
personnel to use particular functions.

The default password for the System Administrator is: SysAdm.
The default password for the Key Operator is: KeyOp.
The default password for the Repro Operator is: ReproOp.
Note: The default passwords are case sensitive. Change the passwords after
your first log on.

▼ How to log on

1 From the ‘File’ menu, select ‘Log on’.
2 Select the correct user name.
3 Enter the Password.
4 Click ‘OK’.

Note: You must log on into each application separately.

Log on is restricted to one user only. When a second user attempts to log on an
error message will appear (see figure below).

[55] When a second user attempts to log on an error message will appear

Log off

You have to log off to leave the key operator, repro operator and system
administrator modes.

▼ How to log off

1 From the ‘File’ menu, select ‘Log off’.
You return to anonymous user mode.
Note: You must log off from each application separately.
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To change the password

You can change your password on a standard base. You can change the
password for each user mode (except anonymous user mode, for which no
password is required and service operator) by taking the following steps:

▼ Change the password

1 From the ‘File’ menu, select ‘Log on’.
2 Click the ‘Password’ button.
3 Select the correct username in the ‘Username’ drop-down list box.
4 Enter the old password in the ‘Password’ text box.
5 Enter the new password in the ‘New password’ text box.
6 Enter he new password in the ‘Confirm new password’ text box and click ‘OK’

to confirm the new password.

Automatic logon

If you do not want to log on each time you start an application, you can select
the automatic logon function. This option allows you to start an application
automatically in the indicated user mode.

▼ Enable automatic log on

1 From the ‘Edit’ menu, select ‘Options’.
The Options window appears.

2 Select the ‘Enable automatic logon’ check box.
3 Select the correct user mode and enter your password for that user mode.
4 Click ‘OK’. Automatic logon is now enabled.
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Language

From the ‘View’ menu, select ‘Language’, to select one of the supported
languages.

Note: The check mark in front of the language indicates that this is the active
display language.

▼ Set the languages

1 From the ‘View’ menu, select ‘Language’.
You have to change the display language setting in the Settings Editor, to
change the languages in the scanner and printer operator panels, and in the
local applications.

Help

▼ Display help information

1 Open the ‘Help’ menu and select ‘Contents’.
Now you can find help for all functions of the Océ Remote Logic®
applications.

Command line parameters

In order to start the remote applications faster, there are 6 command line
parameters available.

configfile=<config_file> Sets the configuration file to use.

server=server Sets the specified server as the server to connect to.

language1=lang Specifies the first language in combination with the
parameter ‘country1=country’.

country1=country Specifies the first language in combination with the
parameter ‘language1=language’.

language2=lang Specifies the second language in combination with the
parameter ‘country2=country’.
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country2=country Specifies the second language in combination with the
parameter ‘language2=language’.

Note: You must always use a matching combination of ‘lang’ and ‘country’
(see table on page 141).

The parameters can be applied to the following applications:
■ QM.exe (Océ Queue Manager)
■ SCP.exe (Océ System Control Panel)
■ SE.exe (Océ Settings Editor)
■ AL.exe (Application launcher)

Note: These.exe files are usually located in ‘C:\Program Files\Remote
Logic\Bin’.

Language
Language Language

parameters
Country

Danish da DK
Czech cs CZ
Spanish es ES
Finnish fi FI
Hungarian hu HU
Italian it IT
US English en US
UK English en GB
Dutch nl NL
German de DE
French fr FR
Portuguese pt PT
Norwegian no NO
Swedish sv SV
Polish pl PL
Chinese tradi-
tional

cn TW

Chinese simpli-
fied

cn CN

Japanese ja JP

[56]
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The easiest way to do this is by creating a short-cut of an application and then
add the command line properties.

Example command line parameter Below is an example of how to start the
Océ Remote Logic® applications with the configuration file ‘Myconfig.cfg’,
connected to the ‘My9600’ server. The first language is set to US English and
the second to French:
‘C\Program Files\Remote Logic\Bin\AL.exe -configFile=Myconfig.cfg
server=My9600 language1=en country1=US language2=fr country2=FR’.
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How to use the remote system

Start up the Océ Remote Logic® applications (Océ Settings editor, Océ Queue
manager, Océ System control panel), on a remote client after you installed the
software (see ‘Installation procedure for MS Windows® systems’ on
page 131). In order to use the functionality you first have to add an Océ Power
Logic® controller and then connect to an available Océ Remote Logic®
controller.

▼ Add an Océ Power Logic® controller

1 Open the ‘File’ menu and select ‘Connect to’.
A dialog box will appear with a drop-down list box containing the already
added Océ Remote Logic® systems.

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.
3 Enter the IP address or the name of the Océ Remote Logic® system you want

to connect to, in the ‘Systems’ text box.
4 Click ‘Add’. The system is added to the list. You can add as many systems.

Note: You can also remove an Océ Remote Logic® system. Select one in the
list and click ‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add an Océ Remote Logic® system, the system has to be
installed and configured by a system consultant or a technician.

▼ Connect to an Océ Power Logic® controller

1 Open the ‘File’ menu and select ‘Connect to’.
A dialog box will appear containing a drop-down list box with the available
systems.
Select one of the available systems and click on ‘OK’. When you connect to
another system, all settings have to be retrieved. This may take some time.
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Chapter 9
Océ Account Center

This chapter describes what Account logging is and how to
use it.
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Introduction

Océ Account Center is an application to manage the account information of the
print, copy and scan-to-file jobs. Océ Account Center consists of the following
two applications:

■ Océ Account Logic.
Océ Account Logic requests the operator and the user to enter account
information. The operator can enter the account information at the Océ
Power Logic® controller for the copy and scan-to-file jobs. The user can
enter the account information at the workstation for the print jobs. Océ
Account Logic runs on the Océ Power Logic® controller and is available
through Internet browser (see ‘Océ Account Logic’ on page 147).

■ Océ Account Console.
Océ Account Console provides options to manage the account information.
The system administrator uses Océ Account Console to define the contents
of the account information in the dialog boxes at the Océ Account Logic
application. Océ Account Console runs on the workstation of the system
administrator. Access to Océ Account Console application is password
protected and limited to the system administrator (see ‘Océ Account
Console’ on page 149).
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Océ Account Logic

Introduction to Océ Account Logic

Use Océ Account Logic to link account information to your job. The account
information requirements are defined and managed by the system
administrator. Use Océ Account Logic for the following.

■ Enter the account information for the print jobs
■ Manage print jobs that do not have valid account information
■ Enter account information for the copy and scan-to-file jobs
■ Lock and unlock the scanner
■ Administer Océ Account Logic (administrators only).

Océ Power Logic® controller setup

Before you begin to use Océ Account Logic, you must define the correct
settings in the Océ Settings Editor.

System setting Reference on Path in Settings Editor
KO - System - Enabling
passwords - Advanced
Queue Manager

Use the correct password
to enable the ‘Advanced
Queue Manager’

Advanced Queue Man-
ager adds the‘Inbox’ fea-
ture to the Océ Queue
manager. Océ Account
Logic requires that you
use the‘Inbox’.

KO - System - Enabling
passwords - Account log-
ging

Use the correct password
to enable account log-
ging.

Before you can use Océ
Account Logic, enable
account logging on Océ
Power Logic® controller
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Note: Please consult the Océ Account Center user manual and the on-line help
in the application for detailed information.

KO - System - Job man-
agement - Print jobs

Select ‘Jobs in inbox’. Océ Account Logic re-
quires that all jobs are
send to the ‘Inbox’.
Note: The print jobs that
have valid account
information are
automatically moved from
the Inbox to the Print queue.
Enter the account
information for the print
jobs that do not have valid
account information on the
‘Print’ tab of Océ Account
Logic.

KO - System - Job man-
agement - Rights for print-
ing

Select ‘Special user’. Océ Account Logic is a
special user on the Océ
Power Logic® control-
ler.

KO - Scanner - Settings -
Timers - Panel timeout

Océ advises you to set
the panel timeout to the
minimum value (30 sec-
onds).

When the check box
‘The scanner locks when
the scanner panel time-
out expires‘ is checked
in the ‘Define the ac-
count information re-
quirements for the jobs’
section of the adminis-
tration window, the user
is required to unlock the
scanner for the copy jobs
and scan-to-file jobs.
The scanner locks when
the scanner panel time-
out expires.

System setting Reference on Path in Settings Editor
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Océ Account Console

Introduction to Océ Account Console

Océ Account Console is installed on a PC that functions as a server. Access to
Océ Account Console is password protected and limited to the administrator.
Use Océ Account Console for the following.

■ Manage, preview, and publish the account information dialog for Océ
Account Logic

■ Retrieve and export the log files.

Summary of Océ Account Console

Océ Account Console has the following three sections.

■ The ‘Account fields’ tab
Use this tab to create, manage, preview, and publish the ‘Account
information’ dialog for Océ Account Logic.

■ The ‘Account data’ tab</ptxt>
Use this tab to define the devices from where the log files are retrieved.
Use this tab to export the log files.

■ The ‘Administration’ window.
Use this screen to define the administrative settings for the application, and
to change the password for Océ Account Console.

Note: Please consult the Océ Account Center user manual and the on-line help
in the application for detailed information.
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Chapter 10
Printer Supplies and Maintenance

This chapter describes how to:
■ Load media
■ Refill toner and replace the waste toner bag
■ Clean the glass platen and the reference roller of the scanner
■ Clean the reinforcement unit
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Media

The Océ TDS400 is available with a roll unit for one or two rolls.

Each of the rolls on the Océ TDS400 can be loaded with print material of a
different size or type. The size and type of the available media are indicated on
the operator panel.

Attention: When you load new print material, you must tell the system the
size of the material and the type of print material (paper, transparent, or
polyester). Refer to ‘Media type and size on the printer’ on page 29.

The definition of the size and type of the new print material is required to:
■ Enable the automatic media switch function to work correctly.
■ Support auto format functions.

The paper rolls

When a roll is empty during a print job, a ‘Roll empty’ message is displayed
at the printer operator panel and on the Océ System Control Panel application.
You then have to load a new roll of print material.

Note: You can use the following media for the Océ TDS400:

■ Plain paper 64 g/m2 (55 g/m2)
■ Plain paper 75 g/m2 (110 g/m2)
■ Biotop paper 80 g/m2
■ Green label 80 g/m2
■ Recyonomic 80 g/m2
■ Transparent paper 75 g/m2
■ Transparent paper 90/95 g/m2 (80/85 g/m2)
■ Transparent paper 110/115 g/m2
■ Translucent 60 g/m2
■ Vellum 20 lbs (16 lbs)
■ Film 3.5 mil (4 mil)
■ Film 4.5 mil
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Reload paper

▼ How to load roll 1

1 Open the drawer completely (see Figure 57).

[57] Open the drawer

2 Remove the roll holder from the drawer (see Figure 58).

[58] Removing the roll holder from the drawer

3 Remove the empty core from the roll holder while pressing the knob (see
Figure 59).

4 Slide the roll holder in the new roll of material while pressing the knob (see
Figure 59). The knob must be at the right hand side and paper must be
positioned as shown in figure 59.
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[59] Press the knob

5 Align the roll with the appropriate lines on the roll holder while pressing the
knob. This line has to be completely visible.

6 Place the roll holder with the material in the drawer (see Figure 60).

[60] Reposition the roll

7 Feed the material between the input guide plates against the rollers.
8 Turn the rollers until the material is visible (see Figure 61). Also refer to the

sticker inside the drawer.

34"
A0 36"
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[61] Feed the material

9 If you have inserted a roll with another material or with a different width, you
have to program the correct width and material type (refer to ‘Media type and
size on the printer’ on page 29).
If you want to cut the paper to get a straight leading strip refer to ‘Cut media’
on page 32.
Otherwise continue with the next step.

10 Close the drawer.
11 Press the On-line key.

▼ How to load roll 2

1 Open the cover to get access to roll 2 (see Figure 62).

[62] Open the lower paper drawer

2 Remove the roll holder (see Figure 63).
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[63] Remove the roll holder from the lower paper drawer

3 Remove the empty core from the roll holder while pressing the knob (see
Figure 59 on page 154).

4 Slide the roll holder in the roll of print material while pressing the knob (see
Figure 59 on page 154).
It is important to have the knob at the right hand side and the paper as shown
in figure 59.

5 Align the roll with the appropriate lines on the roll holder while you press the
knob.
Place the roll holder with the material in the lower paper compartment (see
Figure 64).

da

[64] Reposition the roll in the lower paper drawer

6 Feed the material between the input guide plates against the rollers.Turn the
rollers until the material is visible (see Figure 65). Also refer to the sticker
inside the drawer.
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[65] Feed the material

If you want to cut the paper to get a straight leading strip refer to ‘Cut media’
on page 32.
Otherwise continue with the next step.

7 Close the lower paper compartment.
8 Press the On-line key.

How to program media settings

If you insert a new roll with another material or with a different width, set the
new roll specifications.

The width of the material
Material Size
A0 841 mm
A1 594 mm
A2 420 mm
A3 297 mm
E 86.36 cm
D 55.88 cm
C 43.18 cm
B 27.94 cm
E+ 91.44 cm
D+ 60.96 cm
C+ 45.72 cm
B+ 30.48 cm
76.20 cm 76.20 cm
B1 707 mm
Note: The default is 36 inch

Note:
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The material paper, transparent, transparent 110g, vellum, film, film 4,5,
translucent. Set the material type according to the following table:

Note: if you have a folder the media setting ‘Paper 110 g’ is also available.

B2 500 mm
700 700 mm

Material properties
Material Weight Media Setting
Plain paper 64 g/m2(55 g/m2) Paper 64g
Plain paper 75 g/m2(110 g/m2) Paper 75g
Biotop paper 80 g/m2 Paper 75g
Green label 80 g/m2 Paper 75g
Recyonomic 80 g/m2 Paper 75g
Transparent paper 75 g/m2 Transparent 75g
Transparent paper 90/95 g/m2 (80/85 g/m2) Transparent 75g
Transparent paper 110/115 g/m2 Transparent 110 g
Translucent 60 g/m2 Translucent
Vellum 20 lbs (16 lbs) Vellum
Film 3.5 mil (4 mil) Film 3.5
Film 4.5 mil Film 4.5

[66]

The width of the material

Note: The default is 36 inch

Note:



Printer Supplies and Maintenance 159

How to refill toner

If the ‘Refill toner’ message appears on the printer panel, you must refill toner
immediately.

Attention: Use only B5 toner.

▼ Refill toner

1 Turn off the printer.
2 Unscrew the knurled nut at the left hand side of the printer and open the left

cover (see Figure 67).

[67] Unscrew the knurled nut and open the cover

3 Shake the toner bottle thoroughly and open the bottle.
4 Screw in the bottle clockwise in a slanted position (see Figure 68).
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[68] Screw in the bottle

5 Move the toner bottle to a vertical position (see Figure 69).

[69] Add toner

6 Tap the toner out of the bottle.
7 When the toner bottle is empty return the bottle to the original position.
8 Unscrew the toner bottle anti clockwise.

▼ Replace the waste toner bag

9 Pull the waste toner bag from the holder and place the cap provided on the bag
(see Figure 70).

B5

B5
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[70] Replace the waste toner bag

10 Slide a new waste toner bag over the holder.
11 Close the cover and tighten the knurled nut.
12 Press the On-line key to resume printing.

Note: Replace the toner waste bag, every time you refill the toner.
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Clean the glass platen and the reference
roller of the scanner

If the glass platen of the scanner is dirty or static, it should be cleaned to ensure
top quality copies are produced. At the same time you can clean the white
reference roller.

Attention: When you clean the reference roller, be careful not to damage the
sensors on the scanner

▼ How to clean the glass platen and reference roller

1 Switch off the scanner.
2 Unlock the top cover by pushing the front side of the cover down and pulling

it towards.

[71] Open the top cover of the scanner

3 Raise the cover (see Figure 72 on page 163).
4 Clean the glass platen and the white pressure platen gently with a soft cloth

moistened with a small quantity “Cleaner A”.
For safety information see the safety data sheet in Appendix B.
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[72] Glass platen and reference roller

5 Lower the top cover.
6 Lock the cover by pushing the front side of the cover down and pushing it back

to the rear until you hear a click.
Note: Make sure that the cover is closed correctly, to ensure proper original
transport.

7 Switch on the scanner.
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Maintenance of the reinforcement unit

This section covers maintenance activities for the optional reinforcement unit
of the folder, such as:
■ Insert a new tape roll
■ Empty the waste box
■ Clean the reinforcement knives

Attention: To avoid damage to the reinforcement unit, only use the original
reinforcement strips from Océ.

Insert a new tape roll

When the tape roll is empty while the printer is in stand-by, the following
message will appear on the display: ‘RU tape empty’. Open the reinforcement
unit and replace the empty tape roll.

▼ How to remove an empty tape roll

1 Open the side door of the reinforcement unit (see Figure 73).

[73] Opening the side door of the reinforcement unit

2 Turn the two guide plates away from the pin roller and lock them into their
open position (see Figure 74).
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[74] Opening the guide plates

3 Remove the trailing strip of the old tape (see Figure 75).

[75] Removing the trailing strip of the old tape

4 Open the front side plate of the roll holder by unscrewing the green knurled nut
and remove the old kernel.
Note: Clean the reinforcement knives before you put in a new roll. See
‘Clean the reinforcement knives’ on page 172 for more information.

▼ How to insert a new tape roll

1 Place the new roll and close the side plate. Make certain that the roll is placed
with the holes to the back and the protection sheet to the front (see Figure 76).
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[76] Placing the new roll

2 Detach the end of the roll and lead the tape over the large guide roller (see
Figure 77).

[77] Guiding the tape around the guide roller

3 Lead the tape between the upper and lower knife and over the pin roller (see
Figure 78).
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[78] Leading the tape between upper and lower knife

4 Make certain that at least 200 mm (2 strip lengths) of tape protrude from the
knife section (see Figure 79).

[79] Protruding tape

5 The holes in the tape must be aligned with the hole pattern on the sticker you
can find on the frame plate of the reinforcement unit (see Figure 80). If this is
not the case, you lift the tape from the pin roller and push the tape further
between the two knives until the holes are aligned.
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[80] Adjusting the holes on the tape

6 Close the guide plates of the pin roller (see Figure 81).

[81] Closing the guide plates

▼ How to prepare the tape roll for operation

1 Peel the protection sheet off the tape (see Figure 82).
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[82] Peeling off the protection sheet

2 Lead the protection sheet back between the upper and lower knife.

[83] Leading the protection sheet between upper and lower knife

3 Lift the guide and lead the protection sheet between the protection sheet
rollers, pulling the protection sheet tight (see Figure 84).
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[84] Leading the protection sheet between the rollers

4 Insert the leading strip of the tape into the closed section of the slide (see
Figure 85).

[85] Inserting the tape into the closed section of the slide

5 Hold the upper guide plate down and cut the tape at the knife section by quickly
pulling the strip up so that the tape is cut by the upper knife (see Figure 86).
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[86] Cutting the tape at the knife section

6 Close the side door of the reinforcement unit.

Empty he waste box

If a reinforcement unit is installed, the protective sheet from the reinforcement
tape is stored in a waste box. For each roll of tape the box should be emptied
twice.

Note: You can empty the waste box while the printer is running.

▼ How to empty the waste box

1 Open the waste box by first pulling it to the left hand side and next pulling it
towards you.

[87] Opening the waste box

2 Empty the box.
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3 Close the waste box by first pushing it forwards and next pushing it to the right
hand side.

[88] Closing the waste box

Clean the reinforcement knives

Because the knives of the reinforcement unit get sticky from the glue on the
reinforcement tape, they have to be cleaned regularly. You are recommended
to clean the knives each time you have inserted a new tape roll (see ‘Insert a
new tape roll’ on page 164) or when an error in the reinforcement unit has
occurred.

If you want to clean the reinforcement knives, you have to place them in such
a position that all the parts that need to be cleaned are accessible.

Attention: Only use the original Cleaner K and Fixing Unit Cleaning Oil
(silicon oil) from Océ, to avoid damage to the reinforcement unit.

▼ How to clean the reinforcement knives

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Clean RU knife’ with the or key.
5 Press the key to place the reinforcement unit knives in the correct position.
6 Open the side door of the reinforcement unit.
7 Clean the upper and lower knife using Cleaner K (see Figure 89).



Printer Supplies and Maintenance 173

[89] Cleaning the upper and lower knife

8 Oil the felt using Fixing Unit Cleaning Oil (silicon oil).

[90] Oiling the felt

Close the side door of the reinforcement unit. The knives are automatically
placed back in their home positions., depending on whether or not a job was
interrupted to clean the knives.

9 Press the On-line key.
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Chapter 11
Troubleshooting

This chapter describes the problems that can occur with the
Océ TDS400.
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Introduction

This chapter describes problems that can occur with the Océ TDS400 and how
to correct the problems.

The following problems can occur on the Océ TDS400:
■ Original jams in the scanner (see page 177).
■ Paper jams in the printer (see page 179).
■ Paper jams in the folder (see page 182)
■ Problems with the reinforcement unit (see page 189)

Stickers on parts of the system indicate which green handles, green knobs,
green bars and covers can be lifted, pressed or opened to remove the jammed
material.

If you clear the error, the display gives the instruction on how to continue the
job. Refer to ‘Error messages’ on page 44 for complete information about the
error messages on the printer operator panel.
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Original jams in scanner

If an original jams, you can stop the original with the orange Cancel key.

▼ How to remove a jammed original

1 Unlock the top cover by pushing the front side of the cover down and to pull it
towards you. (see Figure 91).

[91] Open the top cover of the scanner

2 Raise the cover (see Figure 92)

[92] Raise the cover of the scanner
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3 Remove the original.
4 Lower the top cover.
5 Lock the cover by pushing the front side of the cover down and to push it back

to the rear until you hear a click.
Note: Make sure that the cover is closed correctly, to make sure correct
original move.

6 Press the Cancel key.
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Paper jams in the printer

Paper jam in the material feed section

If a jam occurs a message appears on the operator panel. If a paper jam occurs,
check if:
■ The roll is loaded correct and the media is fed as indicated.
■ The correct media is used (see ‘List of available material types and sizes’ on

page 214).
■ No scraps of material are blocking the paper path

▼ How to clear a jam in the material feed section

1 Turn off the printer.
2 Open the correct roll compartment.

Note: One compartment can be open at a time.
3 Lower the feed table, use the two catches on the front underneath the feed table

(see Figure 93).

[93] Lower the feed table

4 Remove the jammed material.
5 Close the feed table.
6 Close the roll compartment.
7 Turn on the printer.

Note: If you can not clear the paper jam by opening the feed table than open
the fusing section (see ‘Paper jam in the fuser section’ on page 180).
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Paper jam in the fuser section

Caution: Open the fuser only to remove the paper after a media jam.
Because of hot surfaces the operator always has to be cautious and wear
heat-protective gloves, when he removes material in the fuser section.

▼ How to clear a jam in the fuser section

1 Turn off the printer.
2 Loosen the screw at the left hand side of the machine and open the cover (see

Figure 94).

[94] Unscrew the knurled nut to open the cover

3 Lift the green handle (see Figure 95).

[95] Lift the green handle

4 Open the fuser unit (see Figure 96).
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Caution: If the printer is used, the fuser can be hot.

[96] Open the fuser section

5 Remove the jammed material.

Attention: Be careful! The toner is not fused.

6 Lift the green handle and close the fuser unit.
7 Close the left cover and tighten the screw.
8 Turn on the printer.

2
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Paper jams in the folder

Any jams in the folder can occur in either the first fold section, the folder
transport section, the second fold section or the belt unit (see page 196).

Paper jam in the first fold section

▼ How to clear a jam in the first fold section

1 Open the top cover of the folder (see Figure 97).
The green light on the right of the folder is blinking quickly.

[97] Top cover of the folder

2 Remove any jammed printing material.
3 Open the cover of the first fold section (see Figure 98).
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[98] Opening first fold section

4 Open the guide plate (see Figure 99).

[99] Opening guide plate

5 Remove any jammed printing material.
6 Close the guide plate.
7 Close the cover of the first fold section.
8 Close the top cover of the folder.

Paper jam in the folder transport section

▼ How to clear a jam in the folder transport section

1 Open the cover of the transport to the first fold delivery (see Figure 100).
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.

[100] Opening the cover of the folder transport section

2 Remove any jammed printing material.
3 Close the cover of the folder transport section from the left side by lifting it up

and pushing the hinge away from you.

Paper jam in the second fold section

▼ How to clear a jam in the second fold section

1 Open the front door of the second fold section (see Figure 101).

[101] Opening the front door of the second fold section

2 Remove any jammed printing material at the bottom of the second fold section.
3 Close the front door of the second fold section.
4 If you have a belt unit, put the belt in an upright position (see Figure 102).
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[102] Putting the belt in an upright position

5 Open the delivery unit (see Figure 103).

[103] Opening the delivery unit

6 Open the guide plate with the green lever (see Figure 104).

[104] Opening the guide plate with the green lever
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7 Remove any jammed printing material.
8 Open the vertical transport with the green lever (see Figure 105).

[105] Opening the vertical transport

9 Remove any jammed printing material.
10 Close the vertical transport (see Figure 106).

[106] Closing the vertical transport

11 Close the guide plate.
12 Close the delivery unit (see Figure 107).
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[107] Closing the delivery unit

Paper jam in the belt unit

▼ How to clear a jam in the belt unit

1 Open the door of the belt unit (see Figure 108).

[108] Opening the belt unit door

2 Squeeze the two green knobs in the upper section of the belt unit and open the
plate (see Figure 109).



188 Océ TDS400 User Manual

[109] Opening the plate

3 Remove any jammed printing material.
4 Squeeze the two knobs again and put the plate in its original position.
5 Release the green lever in the lower section of the belt unit (by slightly lifting

it and pulling it forward) to open the lower plate (see Figure 110).

[110] Opening the lower plate

6 Remove any jammed printing material.
7 Pull up the green lever again (until it locks into position) to close the plate.
8 Close the belt unit door.
9 Put the belt in its operating position by pushing it down gently.
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Problems with the reinforcement unit

If a reinforcement unit is installed, the following errors can occur:
■ Paper jams
■ Tape jams
■ No reinforcement strips on the output

This section explains how these errors can be solved.

Paper jam in the reinforcement unit

▼ How to clear a paper jam

1 Open the cover of the transport to the First Fold delivery and remove all paper
inside (see Figure 111).

[111] Opening the cover of the folder transport section

2 Close the cover of the folder transport section.
3 Open the front door of the reinforcement unit (see Figure 112).
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[112] Opening the front door of the reinforcement unit

4 Open the top cover of the reinforcement unit and remove all paper inside (see
Figure 113).

[113] Opening the top cover of the reinforcement unit

5 Close top cover and side door of the reinforcement unit.

Tape jam in the reinforcement unit

When a tape jam occurs in the reinforcement unit (see Figure 114) the
following message appears on the display: ‘Error in folder’.
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[114] Tape jam in reinforcement unit

▼ How to clear a tape jam

1 Open the front door of the reinforcement unit (see Figure 115).

[115] Opening the front door of the reinforcement unit

2 Turn the two guide plates away from the pin roller and lock them into their
open position (see Figure 116).
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[116] Opening the guide plates

3 Remove all tape between the rollers and knives (see Figure 117).

[117] Removing the tape

4 Lead a new trailing strip of tape between the rollers and knives.

No reinforcement strips on the output without an error message

▼ Solve this error

1 Put the printer off-line by pressing the On-line key on the operator panel.
2 Open the side door of the reinforcement unit.
3 Check if there are loose reinforcement strips in the unit with the protection

sheet still on (see situation B in figure 118).
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[118] Situation A: No mechanical errorSituation B: Mechanical error

4 If there are, remove the tape strips in the reinforcement unit.
Note: If the protection sheet is not on the reinforcement strip (see situation
A in figure 118), there is no mechanical error and you should insert a new
tape roll as described in ‘How to insert a new tape roll’ on page 165. If this
error frequently occurs you should call Customer Service.

5 Remove all tape between the rollers and knives (see Figure 119).

[119] Removing the tape

6 Lead a new trailing strip of tape between the rollers and knives. For more
information see ‘How to insert a new tape roll’ on page 165.
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Chapter 12
The folder

This chapter describes the:
■ Folder
■ Reinforcement unit
■ Belt unit
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Introduction

If you have a folder installed on your Océ TDS400 system, the following two
other optional features are available:
■ Reinforcement unit(see page 202)
■ Belt unit(see page 203)

Océ TDS400 folder

The Océ TDS400 can have a folder to fold your output. The output is folded
according to the selected folding width and length with a drawing method. You
can only fold paper. Polyester, transparent or vellum media cannot be folded.
When you attempt to fold polyester, transparent or vellum media, a media jam
will occur.

[120] Océ TDS400folder

First Fold
Delivery

Second fold
section

First fold section
Folder transport
section

Reinforcement
Unit

Lever BeltStacker
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The Océ TDS400 folder settings

Note: Before you use the folder, switch the lever downward (see Figure 121).
When you want to use the integrated receiving tray, switch the lever upward.

[121] To fold, switch the lever downward

▼ Set the folded output delivery

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Delivery’ with the or key.
5 Press the key to enter the ‘Delivery’ menu.
6 Select ‘Stacker’, ‘First fold’ or ‘Belt’.

▼ Set the folding legend

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Input’ with the or key.
5 Press the key to enter the ‘Input’ menu.
6 Select ‘Legend’ with the or key.
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7 Press the key to enter the ‘Legend’ menu.
8 Select ‘Trailing’ or ‘Leading’.

▼ Set the drawing method

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Input’ with the or key.
5 Press the key to enter the ‘Input’ menu.
6 Select ‘Method’ with the or key.
7 Press the key to enter the ‘Method’ menu.
8 Select ‘Standard’, ‘Afnor’ or ‘Ericsson’.

▼ Set the binding method

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Binding’ with the or key.
5 Press the key to enter the ‘Binding’ menu.
6 Select ‘Off’, ‘On’ or ‘Reinforce’.

Note: to clean the reinforcement knives see page 172.

▼ Set the binding edge value

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Binding edge’ with the or key.
5 Press the key to enter the ‘Binding edge’ menu.
6 If you selected ‘On’ in the ‘Select the binding method’ procedure, enter a range

between 15 - 30 mm in steps of 1 mm; default 20 mm.

▼ Set the folded package length

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Package’ with the or key.
5 Press the key to enter the ‘Package’ menu.
6 Select ‘Length’ with the or key.
7 Press the key to enter the ‘Length’ menu.

Enter a range between 276 - 310 mm in steps of 1 mm; default 297 mm.
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▼ Set the folded package width

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Package’ with the or key.
5 Press the key to enter the ‘Package’ menu.
6 Select ‘Width’ with the or key.
7 Press the key to enter the ‘Width’ menu.

Enter a range between 186 -230 mm in steps of 1 mm; default 210 mm.
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Maximum folding settings for long
prints

First fold output Stacker 2nd fold Stacker 2nd fold Belt 2nd fold

Paper densi-
ty [g/m2]

1 fold
[mm / inch]

2 folds
[mm / inch]

3 folds
[mm / inch]

2 folds
[mm / inch]

60 1220 / 48 1220 / 48 1220 / 48 1220 / 48

75 6000 / 236 2500 / 98 2000 / 79 1220 / 48

110 2500 / 98 1220 / 48 not possible 1220 / 48

Folding settings 75 grams
Output selection Output length Delivery

‘Stacker’ or ‘Belt’ < 2.5 m Delivered on stacker or belt

‘Stacker’ or ‘Belt’ 2.5 m - 6 m First fold only, delivered in
first fold delivery

‘Stacker’ or ‘Belt’ > 6 m
length known at start

Unfolded, delivered in IRT

‘Stacker’ or ‘Belt’ > 6 m
length not known at start

Possible paper jam

‘Stacker’ or ‘Belt’

‘First fold only’ selected < 6 m Delivered in first fold delivery

‘First fold only’ > 6 m
length known at start

Unfolded, delivered in IRT

‘First fold only’ > 6 m
length not known at start

Possible paper jam

Folding settings 110 grams
Output selection Output length Delivery

‘Stacker’ or ‘Belt’ < 1.22 m
(3 folds)

Delivered in first fold delivery

Stacker’ or ‘Belt’ < 1.22 m
(2 folds)

Delivered on stacker or belt

Stacker’ or ‘Belt’ > 1.22 m
< 2.5 m

Delivered in first fold delivery

Stacker’ or ‘Belt’ > 2.5 m Unfolded, delivered in IRT

Stacker’ or ‘Belt’

‘First fold only’ < 2.5 m Delivered in first fold delivery

‘First fold only’ > 2.5 m Unfolded, delivered in IRT
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Off-line folding

An important productivity feature provided by the Océ TDS400 folder is the
possibility to make off-line folds. For off-line folding the same settings can be
made as for normal folding. By default, the predefined settings in the Océ
Settings Editor for off-line folding are used. Polyester or transparent media
cannot be folded. This may result in a media jam.

Note: Use off-line folding only for sheets which do not exceed a maximum
length of 6 m. If you try to fold a sheet longer than 6 m anyway, an error occurs.

▼ Make off-line folds

1 Switch the printer off-line on the printer operator panel and wait for the printer
to finish the jobs that are already in the printer.
Note: Watch the light on the top cover of the folder.
■ If this is off, the printer is on-line and off-line folding is not possible.
■ If this is blinking slowly, the printer is off-line, but the folder still processing

the last prints.
■ If this is blinking rapidly, an error has occurred.
■ If this is on, the printer is off-line and you can feed a sheet.
Note: Also refer to the sticker on the top cover of the folder.

2 Make any settings for (off-line) folding on the printer operator panel.
3 Feed the sheet of paper face down and with the legend on your right-hand side.

Also make certain that you feed the paper with the legend on the right-hand
side (see ‘Océ TDS400 folder’ on page 196 for more information).
Note: Wait until the light on the folder no longer blinks before you feed a
new sheet. Otherwise a media jam may occur.

4 Collect your output.

off-line folding settings
Output selection Output length Delivery

‘Stacker’ or ‘Belt’ =< 2 m Delivered on stacker or belt

‘Stacker’ or ‘Belt’ 2 m - 2.5 m (2 folds) Delivered on stacker or belt

‘Stacker’ or ‘Belt’ 2 m - 2.5 m (3 folds) Stopped in second fold (possible pa-
per jam)

‘Stacker’ or ‘Belt’ > 2.5 m Unfolded, delivered in IRT

‘Stacker’ or ‘Belt’

‘First fold only’ < 6 m First fold only, delivered in first fold
delivery
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Reinforcement unit

If you install a reinforcement unit, output can be delivered with a pre-punched,
self-adhesive strip (see Figure 122).

[122] Example a of reinforcement strip

With this strip the copy can be stored in a binder, without running the risk that
the punching holes tear out. You can unfold a folded map in a binder without
opening the binder mechanism (see Figure 123).

[123] Example of a folded map with a reinforcement strip

The optional reinforcement unit supports all media sizes larger than A4.
Reinforcement is only possible with the Standard folding method.

See‘Clean the reinforcement knives’ on page 172 for more information about
inserting a new tape roll and other maintenance issues.

Protection sheet
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Belt unit

A belt unit offers a large capacity and more flexibility. On the belt unit up to
75 A0 prints can be delivered offset stacked. You can adjust the side guides of
the belt, depending on the width of the folded package.

▼ Set the belt as folded output delivery

1 Press the On-line key on the printer operator panel.
2 Select ‘Folding’ with the or key.
3 Press the key to enter the ‘Folding’ menu.
4 Select ‘Delivery’ with the or key.
5 Press the key to enter the ‘Delivery’ menu.
6 Select ‘Belt’.

▼ Adjusting the side guides of the belt

1 Loosen the nuts (see Figure 124).

[124] Adjusting the side guides of the belt

2 Adjust the plate in accordance with the width of the fold package.
3 Tighten the nuts.
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The Océ TDS400

[125] The Océ TDS400 system

1 Scanner
2 Scanner feed table
3 Output delivery tray

Note: you can replace the output delivery tray by an optional folder (see
Figure 120 on page 196).

4 Scanner operating panel
5 Printer
6 Manual feed
7 Printer operating panel
8 Monitor
9 Cabinet

10 Océ Power Logic® Controller
11 Rolls
12 Integrated Receiving Tray

1 2 3 4 5 6

8

9

10

1112

7
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Printer operator panel

next/select

previous

on-line stop

1

2

3

56

4

1 The graphics display
2 The Previous key
3 The Next/select key
4 The Stop key
5 The Browse keys (left ,

right )
6 The On-line key



208 Océ TDS400 User Manual

Scanner operator panel

Alphanumeric
display

Browse keys

Confirm
key

Strip key

Copy quantity
display

Cancel key

+ key

Zoom key

Exposure key

- key

Start key

Media key

Extra keyOutput keyInput key

+-start cancel

stripexposure

input output extra

set file

zoom

sheet copy

leading

trailing

roll 1

roll 2

manual

media
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Product specifications Océ TDS400

The Océ TDS400 is a wide format low to medium volume print and copy
system.

Printer
Technology Electrophotography (LED) with organic photoconductor

(OPC) drum and closed toner system
Resolution 600 dpi
Speed 3 linear meters p/min. or approx. 2A0s p/min.
Media sources 1 roll version with manual feed

2 roll version with manual feed
2 roll version with manual feed
Extented integrated stacker for up to 100 prints

Output sizes From A3 to A0 and 36”, a maximum of 15 meters long
Media types Plain, translucent, transparent, recycled, fluorescent and

colored papers; films and vellum
Output reception Standard Integrated Receiving Tray (IRT)
Warm up time None, instant behavior
Dimensions 1352 mm (W) x 1250 mm (H) x 899mm (D) including in-

tegrated receiving tray
Weight Model with 1 roll 149 kg

Model with 2 rolls 159 kg

[126]
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Océ Power Logic® Controller
Platform Océ Controller with embedded Windows® XP
Memory 128 MByte RAM standard, expendable to 256 MByte
Disk space High-speed hard disk dedicated to file spooling, and a

high-speed hard disk dedicated to set memory offering
135 A0 storage capacity

File formats HPGL, HPGL2, HPRTL, TIFF 6.0, CALS type 1, NIRS,
EDMICS (C4), CalComp 906/907/951, ASCII, Adobe®
PostScript® 3™

Interfaces Standard: Ethernet 10/100 Mbits/s with RJ45
Optional: Ethernet 10 Mbits/s with BNC and SubD; To-
kenRing 4/16 Mbits/s; Centronics

Network protocols TCP/IP, Novell (IPX, SPX), FTP, LPD
Cabinet An option to store the controller
User Interface GUI with a monitor, keyboard and mouse to use the ap-

plications on the controller
Adobe® Postscript®
3™ / PDF

Enables you to print the Postscript® level 3™ files and
Portable Document Files (PDF), optional.

Print Exec® WorkgroupOptional software which allows you to create and send a
set of plots or drawing files to an Océ TDS printer. You
can send the settings for these jobs from your worksta-
tion, using your web browser.

Account logging An optional feature that enables you to track how many
jobs you make for a customer. This chapter describes how
you use the accounting functionality for this purpose.

Functionality Multiple prints: up to 999
Automatic Language Sensing (ALS)
Auto roll selection and switching
Plot manipulation: rotation, auto scaling
File spooling on the controller
Set memory: send once, process once, print many; capac-
ity to store up to 135 A0s and create identical sets sorted
by page or by set
Concurrent receiving / processing / printing of digital
jobs

[127]
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Océ Remote Logic® software
Software Application Functionality
Océ Queue Manager view status for each job and cancel, hold and restart the en-

tire job
Océ System Control
Panel application

view status and settings of system components

Océ Settings Editor change system settings

[128]

Scanner
Model Free-standing console
Technology CCD, Océ Image Logic® real-time image processing hard-

ware
Speed 3 linear metres per minute or approximately 2 A0s per

minute
Original feed Face down, right aligned

Automatic feed off/on
Rewind original to front off/on

Originals A4 to A0 sizes and 36”, up to 15 metres.
Maximum thickness 1 mm
Exposure control Automatic background compensation, manual fine adjust-

ment.
Special modes: Lines & Text, Photo, Blueprint

Media selection Manual selection of roll 1 or 2 or manual feed.
Reproduction scale Zoom: 25% - 400% (adjustable in 1% programmable fixed

steps)
Scan-to-file zoom: 50% - 200%

Input mode Single sheet
Set (sets processing/set collation)

Other operating functionsConcurrent scanning and printing
Functionality Multi-copy mode: 1-99 copies (scan once, print many)

Pre-programming of next job
Programmable default settings
Standard cut, synchro cut
Scan-to-file (option)
Leading and trailing strip adjustment (remove 400 mm, add
400 mm)

Image editing Image mirroring
Dimensions 1240 mm (W) x 1105 mm (H) x 615 mm (D)
Weight 65 Kg

[129]
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Océ Scan Logic®
Application Océ Scan Manager, integrated scanning solution, including

Océ View Station LT
Scan destinations 6 programmable destinations

Scan to controller
Scan to network directory
File Transfer Protocol (FTP)

Resolution 200, 300, 400 dpi
Data formats Tiff (G3, G4, uncompressed)

CALS type 1
PDF

Scan modes Single scan, batch scanning with or without checkprint
File naming Automatically generate unique file names for each scan
Check print To check your scanned file
Viewing View scans at point of scanning
Océ Image Logic® Optimum scan quality with special original modes
Ease of use STF from scanner panel, scan directly to destination
Requirements 256 Mb on controller and a graphical user interface
Options Océ View Station LT for editing and enhancement of

scanned documents
Océ Batch Processor for automated editing.

Drivers and application software
Océ ADI driver For AutoCAD® 12, 13, and 14

Windows® 95/98®, NT 4.0® and XP
Océ HDI driver For AutoCAD® 2000

Windows® 95/98/2000, NT 4.0® and XP
Océ Windows driver Windows® 95/98/2000, NT 4.0® and XP
Adobe® PostScript®
Level 3™
drivers

For Windows® 95/98/2000, NT 4.0®, XP and Macin-
tosh®

Océ Print Exec® LT Job submission software for Windows® 95/98, NT 4.0®
and XP

Océ Repro Desk A print management solution for the reprographer and
their clients.

Note: Check Océ on the internet at www.oce.com for the latest drivers.

Finishing: output delivery tray
Model Wheeled delivery tray with blower unit
Capacity Up to 150 sheets (media type dependent) from A3 to A0

[130]
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Types of media Plain paper, transparent paper, film, vellum, polyester and
translucent

Dimensions 1170 mm (W) x 1090 mm (H) x 1440 mm (D) with tray ful-
ly extended

Weight 35.5 kg

Finishing: folder
Folding modes On-line fanfold and crossfold, off-line folding

Folding method Standard (=DIN-like), Ericsson, Afnor-like;
Length: 276 - 310 mm
Width: 186 -230 mm
Filing strip: 15 -30 mm

Paper size (75 g/m2),
Width: 279 -914 mm
Length: 210 - 6,000 mm fanfold only;
210 - 2,500 mm for fanfold and crossfold

First fold exit Extra bin for fanfold

Dimensions 2,200 mm (W) x 997 mm (H) x 1,260 mm (D)

Weight 220 kg

Optionals Reinforcement unit
Belt delivery tray for 75 A0

Compact output stacker
Model The transport unit that delivers copies and prints on the

front-side of the printer.
Capacity Up to 100 sheets depending on the material.

[131]

Dew Preventer
Model An optional heater to prevent dampness in media

[132]

[130]



214 Océ TDS400 User Manual

List of available material types and sizes

Océ machines and materials are matched for optimal quality and performance.
It is therefore recommended to use only approved Océ materials in the Océ
TDS400.
A full list of Océ materials suited for use in the Océ TDS400, including plain
paper, transparent paper, colored papers and various polyester films is
available from your Océ representative.

Material types

The following material types are available for the Océ TDS400:

Material Types
Materials Weight
Plain paper 64 g/m2(55g/m2)
Plain paper 75 g/m2(110g/m2)
Plain paper 80 g/m2

Biotop paper 80 g/m2

Green Label 80 g/m2

Recyonomic 60 g/m2

Translucent paper 75 g/m2

Transparent paper 90/95 g/m2

(80/85g/m2)
Transparent paper 110/115 g/m2

Transparent paper 20 lbs (16 lbs)
Top label paper 60 g/m2

Vellum 3.5 mil (4 mil)
Film 4.5 mil
Polyester film 3.5 or 4.5 mil
Special colored paper, etc.

Minimum Maximum
Width 297 mm 914 mm
Length 420 mm 15 m
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The following material sizes are available for the Océ TDS400:

500

Attention: Avoid storing paper in rooms where temperature and humidity
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic
to prevent it absorbing moisture.

DIN range
Material Width [mm] Length [mm]
A3 297 420
A2 420 594
A1 594 841
A0 841 1189

8,5 inch range
Material Width [inch] Length [inch]
11 inch / B 11 17
17 inch / C 17 22
22 inch / D 22 34
34 inch / E 34 44

22.86 cm range
Material Width [inch] Length [inch]
12 inch / B+ 12 18
18 inch / C+ 18 24
24 inch / D+ 24 36
36 inch / E+ 36 48

Other formats
Material Width Length
76.20 cm 76.20 cm 30.48 cm
B1+ 700 mm 1,000 mm
B1 (DIN) 707 mm 1,000 mm
B2+ 500 mm 700 mm
B2 (DIN) 500 mm 707 mm



216 Océ TDS400 User Manual

Automatic format selection

The Océ TDS400 controller switches to the next larger format. For example
you set the 8,5 inch range on the printer. The job you print is an A1 format. The
printer will automatically select the 30 inch format. The next table shows
which format the Océ TDS400 controller chooses if you print a specific format
on a chosen range

.

Reinforcement strips

Information about the different reinforcement strips is available from your Océ
representative.

Automatic format selection
Paper series
DIN DIN carto 21.59 cm Mixed 8,5 and 9,5 inch

DIN range
A3 X X
A2 X X
A1 X X
A0 X X
8,5 inch range
11 inch / B X X
17 inch / C X X
22 inch / D X X
34 inch / E X X
22.86 cm range
12 inch / B+ X
18 inch / C+ X
24 inch / D+ X X
36 inch / E+ X X X X
Other formats
76.20 cm X X
B1 carto X
B1 (DIN) X
B2 carto X
B2 (DIN) X

[133]
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Attention: Only use the original reinforcement strips from Océ, to avoid
damage to the reinforcement unit.
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Summary of standard zoom formats

Standard zoom fixed steps for the DIN paper series [%]
Original A0 A1 A2 A3 91.44 cm B1 B2
A0 100 71 50 35 109 84 59
A1 141 100 71 50 153 119 84
A2 200 141 100 71 218 168 119
A3 283 200 141 100 308 238 168
91.44 cm 107 65 46 32 100 77 55
B1 119 84 59 42 129 100 71
B2 168 119 84 59 183 141 100

[134]

Standard zoom fixed steps for the DIN carto paper
series [%]
Original A0 A1 A2 A3 91.44 cm B1 B2
A0 100 71 50 35 109 83 59
A1 141 100 71 50 153 118 84
A2 200 141 100 71 218 167 119
A3 283 200 141 100 308 236 168
91.44 cm 107 65 46 32 100 77 55
B1 120 85 60 42 130 100 71
B2 168 119 84 59 183 140 100

[135]

Standard zoom fixed steps for the 8,5 inch paper series
[%]
Original
[inch]

11 / B 17 / C 22 / D 24 / D+ 30 34 / E 36 / E+

11 / B 100 154 200 218 273 309 327
17 / C 65 100 129 141 176 200 212
22 / D 50 77 100 109 136 155 164
24 / D+ 46 71 92 100 125 142 150
30 37 57 73 80 100 113 120
34 / E 32 50 65 71 88 100 106
36 / E+ 31 47 61 67 83 94 100

[136]
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Standard zoom fixed steps for the 8,5 & 9 inch mixed
paper series [%]
Original
[inch]

11 / B 12 /
B+

17 / C18 /
C+

22 / D24 /
D+

30 34 / E36 / E+

11 / B 100 109 154 164 200 218 273 309 327
12 / B+ 92 100 142 150 183 200 250 283 300
17 / C 65 71 100 106 129 141 176 200 212
18 / C+ 61 67 94 100 122 133 167 189 200
22 / D 50 55 77 82 100 109 136 155 164
24 / D+ 46 50 71 75 92 100 125 142 150
30 37 40 57 60 73 80 100 113 120
34 / E 32 35 50 53 65 71 88 100 106
36 / E+ 31 33 47 50 61 67 83 94 100

[137]
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Instructions for safe use

Océ designed products have been tested in accordance with the strictest
international safety standards. To help assure safety while working with these
products it is important that you observe the following safety rules:

Maintenance

■ Do not remove any screws from fixed panels.
■ Do not carry-out maintenance activities except for the parts and maintenance

materials mentioned in this manual.
■ Do not place any liquids on the machine.
■ Use maintenance materials or other materials for their original purpose only.

Keep maintenance materials away from children.
■ Do not mix cleaning fluids or other substances.
■ To avoid the risk of introducing hazards, all modifications to Océ equipment

are strictly reserved for properly qualified and trained service technicians.

Connection

■ If for some reason you have to move the machine yourself, please make sure
that the main power point has the right fuse capacity. See the Océ TDS400
safety data sheet in this appendix for information about maximum current.

■ Do not bridge any mechanical or electrical circuit breakers.
■ Do not use an extension lead to connect the machine.
■ This equipment has not been designed for connection to an IT power system.

(An IT power system is a voltage network in which the neutral wire is not
connected to earth).

■ For equipment connected via a wall socket: locate the machine close to a wall
socket that is easily accessible.

■ For equipment connected via a fixed connection to an electricity grid: the
disconnect device in the fixed connection should be easily accessible.
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Surroundings

■ Do not block the ventilation openings of the machine.
■ Ensure that the machine is placed on a level, horizontal surface of sufficient

strength. See the Océ TDS400 safety data sheet in this appendix for
information about the weight of the equipment.

■ Ensure there is sufficient space around the machine. This facilitates
reloading materials as well as maintenance.

■ Do not place the machine in rooms which are subject to excessive vibration.
■ Do not place the machine in rooms which are too small and insufficiently

ventilated. See the Océ TDS400 safety data sheet in this appendix for
information about space and ventilation requirements.

General

■ Always use materials recommended by Océ and developed for this Océ
machine. Materials not approved by Océ may result in defaults in your
machine.

■ Do not use the machine when it is emitting unusual sounds. Remove the plug
from the power socket or switch off the fixed connection to the electricity
grid and contact Customer Service.



224 Océ TDS400 User Manual

Safety data sheets

The disclaimer below is valid for all safety data sheets in this manual.
For questions about Océ products regarding health, safety and environment,
please contact your Océ organization; you can find the address in the last
appendix of this manual.

Disclaimer The safety data sheets in this manual have been compiled to the
best of our knowledge as a compact guide for safe handling of this product. We
reserve the right to revise safety data sheets as new information becomes
available. It is the user’s responsibility to determine the suitability of this
information for the adoption of safety precautions as may be necessary and to
contact the company in order to ensure that the sheet is the latest one issued. If
and in so far as limitation of liability is permitted under the applicable laws, we
do not accept liability for any inaccuracy that may occur in this information.
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Safety data sheet Océ TDS400 printer

The content of this safety data sheet is subject to the disclaimer of liability on page 224 of this manual.

PRODUCT SAFETY DATA SHEET

Océ-USA, Inc.

Number E-717-a-US
Date August 2000

Copyright © 2000 Océ-Technologies B.V., Venlo, NL

Model Océ TDS400 printer

Description Electrophotographic printer, instant printing, console model, plain paper, organic 
photoconductive drum, powder toner

Max. process speed 3 m/min

Dimensions
Width

Engine Controller
1 roll 2 roll

1352 mm 1352 mm 206 mm
Depth 899 mm 899 mm 437 mm
Height 1251 mm 1251 mm 444 mm

Weight 175 kg 185 kg 15 kg

Voltage 100/115/230 V 100/115/230 V 100/230 V
Frequency 50/60 Hz 50/60 Hz 50-60 Hz
Current-rated 15/15/7,5 A 15/15/7,5 A 0,9 A
Current-max 20/20/10 A 20/20/20/10 A 6/3 A
Power consumption, stand by 30 W  
Power consumption, operation 1,5 kW 4 0 W
EPA ENERGY STAR ®
* Power consumption sleep mode 42 W (total system)
Mains connection Cable with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at bystander position)

Standby In operation
24 dB(A) main body 54 dB(A)

impulse  Li = 4 dB(A)
Sound power level 40 dB(A) main body 62 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH).
Heat emission Standby 70 W; at continuous operation 1,5 kW
Ozone emission 0,04 mg/min at continuous operation

Room volume Recommendation: min. 25 m3

Room ventilation Recommendation: min. 12,5 m3/h (natural ventilation)

Use simulation at random
operation

With a room volume and ventilation as recommended and a daily volume of 150 m (much 
more than average) the use simulation at random operation gives the following ozone 
concentrations:
- Time weighted average 0,01 mg/m3 (0,005 ppm)
- Peak 0,002 mg/m3 (0,001 ppm)
Threshold Limit Value/Occupational Exposure Limit
(Time Weighted Average) for ozone 0,2 mg/m3 (0,1 ppm)
Odour Perception Limit for ozone 0,04 mg/m3 (0,02 ppm)

Consumables Océ OPC Drum (Océ Safety Data Sheet E-218)
Océ B5 Toner (Océ Safety Data Sheet E-199)
Océ D5 Developer (Océ Safety Data Sheet E-200)
Océ Copying Materials.
This apparatus is suitable for processing recycling paper which complies with the 
requirements of ENV 12281.

Additional safety information The ozone filter does not have to be replaced to keep the ozone concentration in the 
workplace below 0,04 mg/m3 (i.e. the life of the filter equals that of the apparatus).

Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950 EPA ENERGY STAR ®

LISTED 927F

INFORMATION
TECHNOLOGY
EQUIPMENT

E 69871
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Safety data sheet Océ TDS400 printer and scanner

The content of this safety data sheet is subject to the disclaimer of liability on page 224 of this manual.

PRODUCT SAFETY DATA SHEET

Océ-USA, Inc.

Number E-718-a-US
Date August 2000

Copyright © 2000 Océ-Technologies B.V., Venlo, NL

Model Océ TDS400

Description Multifunction device, instant copying/printing, consisting of an electrophotographic printer,
console model, plain paper, organic photoconductive drum, powder toner and a free standing
scanner.

Max. process speed 3 m/min

Dimensions Width
Engine Scanner Controller Monitor (17”)

1352 mm 1240 mm 206 mm 299 mm
Depth 899 mm 615 mm 437 mm 410 mm
Height 1251 mm 1105 mm 444 mm 409 mm

Weight 175 kg 65 kg 15 kg 15 kg
10 kg (extra roll)

Voltage 100/115/230 V 100/115/230 V 100/230 V 100-230 V
Frequency 50/60 Hz 50-60 Hz 50-60 Hz 50-60 Hz
Current-rated 15/15/7,5 A 1,1/1,1/0,7 A 0,9 A
Current-max 20/20/10 A 1,6/1,6/0,8 A 6/3 A 1,4 A
Power consumption, stand by 30 W 27 W
Power consumption, operation 1,5 kW 1 40 W 40 W 70 W
EPA ENERGY STAR ®
* Power consumption sleep mode 52 W (total system)
Mains connection Cables with plug
Safety class I (IEC 536) Protective earth connection
Protection class IP 20 (IEC 529)

Sound pressure level
(at bystander position)

Standby In operation
24 dB(A) main body 54 dB(A)

impulse Li = 4 dB(A)
Sound power level 41 dB(A) main body 63 dB(A)
Radio interference Complies with Directive 89/336/EEC and FCC rules and regulations, part 15 Class A.
Radiation Below the Threshold Limit Values for UV, Visible and IR radiation (TLV list of ACGIH)
Heat emission Standby 182 W; at continuous operation 1,8 kW
Ozone emission 0,04 mg/min at continuous operation

Room volume Recommendation: min. 25 m3

Room ventilation Recommendation: min.12,5 m3/h (natural ventilation)
Use simulation at random
operation

With a room volume and ventilation as recommended and a daily volume of 150 m (much
more than average) the use simulation at random operation gives the following ozone
concentrations:
- Time weighted average 0,01 mg/m3 (0,005 ppm)
- Peak 0,002 mg/m3 (0,001 ppm)
Threshold Limit Value/Occupational Exposure Limit
(Time Weighted Average) for ozone 0,2 mg/m3 (0,1 ppm)
Odour Perception Limit for ozone 0,04 mg/m3 (0,02 ppm)

Consumables Océ OPC Drum (Océ Safety Data Sheet E-218)
Océ B5 Toner (Océ Safety Data Sheet E-199)
Océ D5 Developer (Océ Safety Data Sheet E-200)
Océ Copying Materials.
This apparatus is suitable for processing recycling paper which complies with the
requirements of ENV 12281.

Additional safety information The ozone filter does not have to be replaced to keep the ozone concentration in the
workplace below 0,04 mg/m3 (i.e. the life of the filter equals that of the apparatus).

Listed according to standard UL 1950 and CAN/CSA-C22.2 No.950 EPA ENERGY STAR ®

LISTED 927F

INFORMATION
TECHNOLOGY
EQUIPMENT

E 69871
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EPA ENERGY STAR®

Océ-Technologies B.V. has joined the ENERGY STAR® Program of the United
States Environmental Protection Agency (EPA). The purpose of the ENERGY

STAR® Program is to promote the manufacturing and marketing of
energy-efficient equipment, thereby potentially reducing combustion-related
pollution. Using the energy management features outlined below prevents
unnecessary power consumption, which helps to prevent air pollution from
electricity generating plants and saves you money on your utility bills.

As an ENERGY STAR® Partner, Océ-Technologies B.V. has determined that this
copier model meets the ENERGY STAR® guidelines for energy efficiency.

The EPA ENERGY STAR® Criteria for copiers involve the following features:

low power mode In the low power mode, the power consumption of certain
functions is automatically reduced to save energy. The printer enters the low
power mode 30 minutes after the last copy is made1. This default time can be
adjusted by the key operator to between 5 and 120 minutes. The scanner enters
the low power mode 10 minutes after the last copy is made1. This default time
can be adjusted by the key operator to between 5 and 120 minutes. The low
power mode recovery time is less than 1 second, after which, copying may be
resumed.

recycled copier paper The use of recycled paper also benefits the
environment. This copier is designed to use recycled paper. Product literature
on recommended types of recycled copier paper can be obtained from your
local Océ company or Océ Headquarters (Océ-Technologies B.V.) in Venlo,
the Netherlands.

1For power consumption data: see Product Safety Data Sheet in this appendix.

ENERGY STAR® is a U.S. registered mark.
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How to read this manual

The consistent style that is used in this manual enables you to quickly become
familiar with the use of this manual and ultimately the Océ TDS400.

Description Each section or subsection contains a description of the feature or
operation identified in the title. It might also include possible applications, as
well as any guidelines that you should bear in mind.

Procedures A description is followed by a procedure. A procedure always
begins with a phrase which briefly describes the procedure, followed by a
series of numbered steps that take you, step by step, through all phases of
performing the operation.

Figures and tables Figures and tables are titled and numbered sequentially
throughout this manual. Figures include pictures of product components,
screen dumps, examples, and diagrams of concepts discussed in the
description.

Attention getters There are several types of information to which we draw
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the proper
functioning of the machine or application, but useful advice concerning its
operation may also be given.

Attention: The information that follows ‘Attention’ is given to avoid
damage to your copy or original, the copier or printer, data files, etc.

Caution: The information that follows ‘Caution’ is given to prevent you
suffering personal injury. .
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User survey

Did you find this manual to be accurate?
❏ Yes
❏ No

Were you able to operate the product after reading this manual?
❏ Yes
❏ No

Does this manual provide adequate background information?
❏ Yes
❏ No

Is the format of this manual convenient in size, easy to read and layed out well?
❏ Yes
❏ No

Did you find the information you were looking for?
❏ Always
❏ Most of the times
❏ Sometimes
❏ Not at all

How did you find the information you were looking for?
❏ Table of contents
❏ Index
❏ Neither

Are you satisfied with this manual?
❏ Yes
❏ No

Thank you for evaluating this manual.
If you have any other comments or concerns, please explain them on the
following page.
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Comments:

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------
Date:

This reader’s comment sheet is completed by:

Name (optional):

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
Attn: ITC-User Documentation
P.O. Box 101
5900 MA Venlo
The Netherlands

Send you comments by E-mail to : itc-userdoc@oce.nl

For the addresses of local Océ organizations see : www.oce.com
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Addresses of local Océ organizations

Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada

Océ Office Equipment (Beijing) Co Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-Česká republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic

Océ-Danmark A.S.
Kornmarksvej 6
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
4330 Mülheim an der Ruhr (13)
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia
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Océ-Nederland B.V.
P.O.Box 800
5201 AV ‘s-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. Łopuszańska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 1231
S-164 28 Kista
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland

Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 60656
U.S.A.
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Index

A
access 108
account center 145
account console 149
Account logic 147
add a controller 143
add toner 159

replace waste toner bag 159
Advanced printing 35
alphanumeric display 25
applications 130
apply 105
auto-feed 75
Automatic format selection 216
Automatic logon 139
automatically view a scanned file 92
available material types and sizes 11, 214

B
belt unit 196, 203
binding method 198
binding strip 198

C
cancel key 64
cleaner A 162
clear media jam

fuser section 180
roll feed section 179

clear paper jams
folder 182

Clear set memory 41
command line parameters 140
Compact output stacker 213
compression 80
configuration report 33
connect to a controller 143

Connecting 143
connecting workstations 94
controller

shut down 101
start up 101

copy process
start 54

cut media 32

D
delete a scanned file 91
deleting print jobs 127
demo print 34
destination 77, 78

delete 89
lock 88
unlock 89

destination properties 90
Diagnostic mode 41
display (printer)

Error messages 44
Status messages 42

Display language 140
drawing method 198
Drivers 212

E
Energy Star 227

F
file type 77
folded copies 196
folded package length 198
folded package width 199
folder 196
Folder options

belt unit 196
reinforcement unit 196

folding settings 200, 201
FTP 93
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G
general control buttons 108
get files 93

H
help 140
How to use the remote system 143

I
input key 49
install remote logic 131
IP address. 38

J
Japan support 16

destination names 88

K
key operator settings 102
keys 26

selection keys 26
stop 26

L
language 140
load media 152
Log off 138
Log on 138

M
maintenance

glass platen 162
reference roller 162

reinforcement unit 164
make a scan

how to 75
Manage print jobs 127
manual feed 13, 61
Material

types 214
Material properties 158
menu bar 104
menu level indicator 25, 51
move a job to top 128

N
network settings 38

default gateway 38
IP address 38
subnetmask 38

networksettings
DHCP server 38

O
océ print exec workgroup 35
Océ Remote Logic 129

User modes 137
Océ Repro Desk 37
Océ TDS400 applications

Queue Manager 15
scan manager 83
System Control Panel 14

Océ TDS400 folder 195
Océ TDS400 system 12
off-line folding 200, 201
on/off switch printer 27, 53
on/off switch scanner 53
optional

Automatic 2-roll unit 15
Compact output stacker 15
Graphical User Interface 16
Scan-to-File 16

organization 80
original guide line 54
original jam 177
output delivery tray 212
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output key 49

P
paper jam

belt unit 187
folder 182
folder transport section 183
reinformcement unit 189
second fold section 184

paper series 41
21.59 cm 41
DIN 41
DIN CARTO 41
mix 8.5/9 inch 41

password 139
Power Logic Controller 14
pre-cut copy material 61
print

configuration report 33
demo print 34
menu card printer 33

print a scanned file 90
print exec workgroup 35
print queue 127
print with oce repro desk 37
printer 13
printer keys 26
printer menu 33
printer settings

selecting language 38
set a special media indication 29
stopping print job 38

problems 176
product specifications 209

Drivers and application software 212
Power Logic controller 210
Printer 209
Remote Logic software 211
Scan Logic 212

program media settings 157
properties of a scanned file 91

Q
Queue Manager 122

active print job window 122
deleting print jobs 127
functions 122
introduction 15, 122
menu bar 122
modes 124
move a job to top 128
pausing print jobs 127
possibilities 122
print queue window 123
restart paused print job 128
restart paused print jobs 128
structure 122
viewing the print queue 127
window 124

Queue Manager window 117

R
refill toner 159
reinforce 198
Reinforcement strips 216
reinforcement unit 196, 202
release paper 75
Remote Logic

languages 140
Repro Desk 37
repro operator settings 18, 102
resolution 77, 78
restart a paused print job 128
retrieve scanned files 93
rewind original 75

S
Safety data sheets

Océ TDS400 printer 225
Océ TDS400 printer and scanner 226

safety data sheets 224
safety information 222
Scan jobs

Leading and trailing strip 66
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Scan Manager
destination

lock 88
local destination 86
network destination 87
web destination 88

scanner 13
scanner display 50
scanner feed table 54
scanner operating panel

keys 49
Scan-to-file

destination
ftp 88
local 86
smb 87

scan-to-file
file name 89
password 74
settings 77

select language 38
selection keys 26
set

default gateway 40
IP address 39
language 38
media type 30
media width 30
paper series 41
Subnetmask 40
time-out manual feed 31
use DHCP server 39

Set default gateway 38
set media type and size 29
set memory 41
setting dependencies 102
settings area 106
Settings Editor 14
Stamping 68
standard cut 52
standard zoom formats 218
status bar 108
stop a copy job 64
stop key 26
Subnetmask 38
switching off

scanner 54
switching on

scanner 53
synchro cut 52
system administrator settings 102
System Control Panel (SCP)

icons 118
introduction 14, 116
structure 116

System menu 38
enter 39

T
table view 84

file properties 84
tape jam in reinforcement unit 190
temporary store 92
tiff subformat 80
time-out manual feed 31
top cover of the scanner 162, 177
tree structure 106
tree view 84

destinations 84
turn off

printer 28
turn off the printer 27
turn on

printer 27
Turn on the controller 28
turn on the printer 27
Turn the controller off 28

U
undo 105
Unix 133
update area 107
Use DHCP server 38
User modes 137
user modes 108

V
view a scanned file 90
View error 98
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view printer status 115
view station 95
view station LT 74

see a scanned file 75

W
waste box 171
waste toner bag 159, 160
width of the material 157
work on a remote system 143
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